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PROGRAM OUTCOMES (POs) 

A B.Tech – graduate should possess the following Program outcomes. 

 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering fundamentals, 

and an engineering specialization to the solution of complex engineering problems. 

 

2. Problem analysis: Identify, formulate, review research literature, and analyze complex engineering 

problems reaching substantiated conclusions using first principles of mathematics, natural sciences, 

and engineering sciences. 

 

3. Design/development of solutions: Design solutions for complex engineering problems and design 

system components or processes that meet the specified needs with appropriate consideration for the 

public health and safety, and the cultural, societal, and environmental considerations. 

 

4. Conduct investigations of complex problems: Use research-based knowledge and research methods 

including design of experiments, analysis and interpretation of data, and synthesis of the information 

to provide valid conclusions. 

 

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modelling to complex engineering activities with an 

understanding of the limitations. 

 

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to the 

professional engineering practice. 

 

7. Environment and sustainability: Understand the impact of the professional engineering solutions in 

societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development. 

 

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of 

the engineering practice. 

 

9. Individual and team work: Function effectively as an individual, and as a member or leader in 

diverse teams, and in multidisciplinary settings. 

 

10. Communication: Communicate effectively on complex engineering activities with the engineering 

community and with society at large, such as, being able to comprehend and write effective reports 

and design documentation, make effective presentations, and give and receive clear instructions. 

 

11. Project management and finance: Demonstrate knowledge and understanding of the engineering 

and management principles and apply these to one’s own work, as a member and leader in a team, to 

manage projects and in multidisciplinary environments. 

 

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change. 

 

 

 

 



 

OBJECTIVE 

 The objective of the laboratory is learning. The experiments are designed to 

illustrate phenomena in different areas of Workshop and to expose you to uses of 

instruments. Conduct the job with interest and an attitude of learning. 

To familiarise with the basic manufacturing processes and to study the 

various tools and equipment used, hands-on training is given in different sections. 

Essentially student should know the labour involved, machinery or equipment 

necessary, time required to fabricate and also should be able to estimate the cost of 

the product or job work. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

SAFETY RULES & UNSAFE PRACTICES 
 

 

Remember that “accidents do not occur, they are caused”. With this in mind, strictly follow 

the general safety rules given below and safe practices indicated in brief under each section. 

 

1. Safety first, work next.  
 
2. Know your job and follow instructions.  
 
3. Avoid wearing clothing that might catch, moving or rotating parts. Long sleeves of 

shirts, long hair, neck tie and jewellery are definite hazards in the shop.  
 
4. Wear safety shoes. Do not wear canvas shoes; they give no resistance to hard 

objects dropped on the feet.  
 
5. Keep the area around machine or work clean.  
 
6. Keep away from revolving work.  
 
7. Be sure that all gaurds are in place.  
 
8. One person only should operate the machine controls.  
 
9. Use tools correctly and do not use them if they are not in proper working condition.  
 
10. Wear safety goggles when working in areas, where sparks or chips of metal are 

flying.  
 
11. Get to know who is in-charge of first aid and where boxes are placed and where 

the first aid can be found in case of emergency.  
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 Student able to learn about different tools used in the lab 

 Student able to learn about foundry, welding, plumbing, house wiring and Tin smithy 

operations 

 Student able to learn about different Carpentry and Fitting tools 

 

1. TRADES FOR EXERCISES: 

At least two exercises from each trade: 

1. Carpentry  

2. Fitting  

3. Tin-Smithy and Development of jobs carried out and soldering.  

4. Black Smithy  

5. House-wiring  

2. TRADES FOR DEMONSTRATION & EXPOSURE:  

1. Plumbing  

2. Machine Shop  

3. Welding  

4. Foundry 

5. Metal Cutting (Water Plasma)  

 

TEXT BOOK: 

1. Work shop Manual - P.Kannaiah/ K.L.Narayana/ Scitech Publishers. 
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Course Outcomes: 

 Students can understand different machine shop operations 

 Students can understand Foundry, welding, plumbing, house wiring and Tin smithy 
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1. FITTING 

Introduction 

 

Machine tools are capable of producing work at a faster rate, but, there are occasions when 

components are processed at the bench. Sometimes, it becomes necessary to replace or repair 

component which must be fit accurately with another component on reassembly. This 

involves a certain amount of hand fitting. The assembly of machine tools, jigs, gauges, etc, 

involves certain amount of bench work. The accuracy of work done depends upon the 

experience and skill of the fitter. 

 

The term ‘bench work’ refers to the production of components by hand on the bench, where 

as fitting deals which the assembly of mating parts, through removal of metal, to obtain the 

required fit. 

 

Both the bench work and fitting requires the use of number of simple hand tools and 

considerable manual efforts. The operations in the above works consist of filing, chipping, 

scraping, sawing drilling, and tapping. 
 
Holding Tools: 

 

Bench Vice 

 

The bench vice is a work holding device. It is the most commonly used vice in a fitting shop. 
The bench vice is shown in figure below. 

 

It is fixed to the bench with bolts and nuts. The vice body consists of two main parts, fixed 

jaw and movable jaw. When the vice handle is turned in a clockwise direction, the sliding jaw 

forces the work against the fixed jaw. Jaw plates are made of hardened steel. Serrations on 

the jaws ensure a good grip. Jaw caps made of soft material are used to protect finished 

surfaces, gripped in the vice. The size of the vice is specified by the length of the jaws. 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Bench Vice 
The vice body is made of cast iron which is strong in compression, weak in tension and so 
fractures under shocks and therefore should never be hammered. 

 

 

V‐block is rectangular or square block with a V‐groove on one or both sides opposite to each 

other. The angle of the ‘V’ is usually 90
0
. V‐block with a clamp is used to hold cylindrical 

work securely, during layout of measurement, for measuring operations or for drilling for this 
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the bar is faced longitudinally in the V‐Groove and the screw of V‐clamp is tightened. This 

grip the rod is firm with its axis parallel to the axis of the v‐groove. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: V‐ Block Fig: C ‐ Clamp 
 

C‐ Clamp 

This is used to hold work against an angle plate or v‐block or any other surface, when 

gripping is require Its fixed jaw is shaped like English alphabet ‘C’ and the movable jaw is 

round in shape and directly fitted to the threaded screw at the end .The working principle of 

this clamp is the same as that of the bench vice. 
 
Marking and Measuring Tools: 
 
Surface Plate 
The surface plate is machined to fine limits and is used for testing the flatness of the work 

piece. It is also used for marking out small box and is more precious than the marking table. 

The degree of the finished depends upon whether it is designed for bench work in a fitting 

shop or for using in an inspection room; the surface plate is made of Cast Iron, hardened Steel 

or Granite stone. It is specified by length, width, height and grade. Handles are provided on 

two opposite sides, to carry it while shifting from one place to another (refer figure in next 

page). 
 
 
 
 

 

 

 

 
It is measuring and marking tool for 90

0
 angle .In practice, it is used for checking the 

squareness of many types of small works when extreme accuracy is not required .The blade 

of the Try square is made of hardened steel and the stock of cast Iron or steel. The size of the 

Try square is specified by the length of the blade. 
 
Scriber 

A Scriber is a slender steel tool, used to scribe or mark lines on metal work pieces. It is made 

of hardened and tempered High Carbon Steel. The Tip of the scriber is generally ground at 
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12
o
to 15

o
. 

 
It is generally available in lengths, ranging from 125mm to 250mm .It has two pointed ends 
the bent end is used for marking lines where the straight end cannot real. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square Fig: Scriber 
 
Odd Leg Caliper 

This is also called ‘Jenny Caliper’ or Hermaphrodite. This is used for marking parallel 

liners from a finished edge and also for locating the center of round bars; it has one leg 

pointed like a divider and the other leg bent like a caliper. It is specified by the length of the 

leg up to the hinge point. 

Divider 
It is basically similar to the calipers except that its legs are kept straight and pointed at the 

measuring edge. This is used for marking circles, arcs laying out perpendicular lines, by 

setting lines. It is made of case hardened mild steel or hardened and tempered low carbon 

steel. Its size is specified by the length of the leg. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Odd Leg Caliper and Divider 
 
 

Trammel is used for drawing large circles or arcs. 

Punches 
These are used for making indentations on the scribed lines, to make them visible clearly. 

These are made of high carbon steel. A punch is specified by its length and diameter (say as 

150’ 12.5mm). It consists of a cylindrical knurled body, which is plain for some length at the 

top of it. At the other end, it is ground to a point. The tapered point of the punch is hardened 

over a length of 20 to 30mm. 

 

Dot Punch is used to lightly indent along the layout lines, to locate center of holes and to 

provide a small center mark for divider point, etc. for this purpose, the punch is ground to a 

conical point having 60° included angle. 
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Center Punch is similar to the dot punch, except that it is ground to a conical point having 

90° included angle. It is used to mark the location of the holes to be drilled. 
 
 
 
 
 
 
 
 
 
 

Fig: Punches 

Calipers: 

They are indirect measuring tools used to measure or transfer linear dimensions. These are 

used with the help of a steel Rule to check inside and outside measurements. These are made 

of Case hardened mild steel or hardened and tempered low carbon steel. While using, but the 

legs of the caliper are set against the surface of the work, whether inside or outside and the 

distance between the legs is measured with the help of a scale and the same can be transferred 

to another desired place. These are specified by the length of the leg. In the case of outside 

caliper, the legs are bent inwards and in the case of inside caliper, the legs bent outward. 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                              Fig: Calipers 

Cutting Tools: 
 
Hack Saw 
The Hack Saw is used for cutting metal by hand. It consists of a frame, which holds a thin 

blade, firmly in position. Hacksaw blade is specified by the number of teeth for centimeter. 

Hacksaw blades have a number of teeth ranging from 5 to 15 per centimeter (cm). Blades 

having lesser number of teeth per cm are used for cutting soft materials like aluminum, brass 

and bronze. Blades having larger number of teeth per centimeter are used for cutting hard 

materials like steel and cast Iron. 
 
 
 
 
 
 
 
 
 

 

Fig: Hacksaw Frame with Blade 
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Hacksaw blades are classified as (i) All hard and (ii) flexible type. The all hard blades are 

made of H.S.S, hardened and tempered throughout to retain their cutting edges longer. These 

are used to cut hard metals. These blades are hard and brittle and can break easily by twisting 

and forcing them into the work while sawing. Flexible blades are made of H.S.S or low alloy 

steel but only the teeth are hardened and the rest of the blade is soft and flexible. These are 

suitable for use by un‐skilled or semi‐skilled persons. 

 
The teeth of the hacksaw blade are staggered, as shown in figure and known as a ‘set of 

teeth’. These make slots wider than the blade thickness, preventing the blade from jamming. 
 
 
Chisels 

 

Chisels are used for removing surplus metal or for cutting thin sheets. These tools are made 

from 0.9% to 1.0% carbon steel of octagonal or hexagonal section. Chisels are annealed, 

hardened and tempered to produce a tough shank and hard cutting edge. Annealing relieves 

the internal stresses in a metal. The cutting angle of the chisel for general purpose is about 

60°. 
 
 
 
 
 
 
 
 

Fig: Flat Chisel 
 
 

Twist Drill 

 

Twist drills are used for making holes. These are made of High speed steel. Both straight and 

taper shank twist drills are used. The parallel shank twist drill can be held in an ordinary self 

– centering drill check. The tapper shank twist drill fits into a corresponding tapered bore 

provided in the drilling machine spindle (see figure in next page). 
 
Taps and Tap Wrenches 

 

A tap is a hardened and steel tool, used for cutting internal thread in a drill hole. Hand Taps 

are usually supplied in sets of three in each diameter and thread size. Each set consists of a 

tapper tap, intermediate tap and plug or bottoming tap. Taps are made of high carbon steel or 

high speed steel (see figure in next page). 

Bench Drilling Machine 
Holes are drilled for fastening parts with rivets, bolts or for producing internal thread. Bench 

drilling machine is the most versatile machine used in a fitting shop for the purpose. Twist 

drills, made of tool steel or high speed steel are used with the drilling machine for drilling 

holes. 
 
Following are the stages in drilling work 
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1. Select the correct size drills, put it into the check and lock it firmly  
 
2. Adjust the speed of the machine to suit the work by changing the belt on the pulleys. Use 

high speed for small drills and soft materials and low speed for large diameter drills and 

hard materials.   
3. Layout of the location of the pole and mark it with a center punch.  
 
4. Hold the work firmly in the vice on the machine table and clamp it directly on to the 

machine table.  
 
5. Put on the power, locate the punch mark and apply slight pressure with the Feed Handle.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Bench Drill 

Finishing Tools: 
 
Reamers 

Reaming is an operation of sizing and finishing a drilled hole, with the help of a cutting tool 

called reamer having a number of cutting edges. For this, a hole is first drilled, the size of 

which is slightly smaller than the finished size and then a hand reamer or machine reamer is 

used for finishing the hole to the correct size. 
 
Hand Reamer is made of High Carbon Steel and has left‐hand spiral flutes so that, it is 

prevented from screwing into the whole during operation. The Shank end of the reamer is 

made straight so that it can be held in a tap wrench. It is operated by hand, with a tap wrench 

fitted on the square end of the reamer and with the work piece held in the vice. The body of 

the reamer is given a slight tapper at its working end, for its easy entry into the whole during 

operation, it is rotated only in clock wise direction and also while removing it from the 

whole. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Reamers 
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Files 

 

Filing is one of the methods of removing small amounts of material from the surface of a 

metal part. A file is hardened steel too, having small parallel rows of cutting edges or teeth 

on its surfaces. 

 

On the faces, the teeth are usually diagonal to the edge. One end of the file is shaped to fit 

into a wooden handle. The figure shows various parts of a hand file. The hand file is parallel 

in width and tapering slightly in thickness, towards the tip. It is provided with double cut 

teeth. On the faces, single cut on one edge and no teeth on the other edge, which is known as 

a safe edge. 
 
 
 
 
 
 
 

 

Fig: Parts of a Hand File 

 
Files are classified according to their shape, cutting teeth and pitch or grade of the teeth. 
The figure shows the various types of files based on their shape. 
 
 
 
 
 
 
 
 
 
 

Fig: Single and Double Cut Files 

Miscellaneous Tools: 
 

Ball‐ Peen Hammer 

Ball‐ Peen Hammers are named, depending upon their shape and material and specified by 

their weight. A ball peen hammer has a flat face which is used for general work and a ball 

end, particularly used for riveting. 
 
 

 

 

 

Cross‐Peen Hammer 

 

It is similar to ball peen hammer, except the shape of the peen. This is used for chipping, 
riveting, bending and stretching metals and hammering inside the curves and shoulders. 
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Fig: Cross Peen Hammer Fig: Straight Peen Hammer 
 

Straight‐Peen Hammer 

 

This is similar to cross peen hammer, but its peen is in‐line with the hammer handle. It is 

used for swaging, riveting in restricted places and stretching metals. 
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Viva Questions 

 
Question: Define the terms: Fitting and Bench work. 
 
Question: Name the material with which a vice body is normally made of. What is the 

characteristic of this material? 
 
Question: What for a C-clamp is used? 
Question: Classify hacksaw blades. 
 
Question: Differentiate between ‘Single cut’ and ‘Double cut’ files. 

Question: Differentiate between ‘Cross filing’ and ‘Draw filing’. 
Question: Name the different types of hammers used in fitting work. 
 
Question: Differentiate between cross-peen hammer and straight-peen hammer. 
Question: What is meant by pinning of files?  
Question: With what the size of a spanner is denoted? 
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2. CARPENTRY 
 
Introduction 

Carpentry may be defined as the process of making wooden components. It starts 

from a marketable form of wood and ends with finished products. It deals with the building 

work, furniture, cabinet making. Etc. joinery, i.e., preparation of joints is one of the important 

operations in all woodworks. It deals with the specific work of carpenter like making 

different types of joints to form a finished product. 
 
Timber: 

 
Timber is the name given to the wood obtained from well grown trees. The trees are 

cut, sawn into various sizes to suit building purposes. 

 

The word, ‘grain’, as applied to wood, refers to the appearance or pattern of the wood 

on the cut surfaces. The grain of the wood is a fibrous structure and to make it strong, the 

timber must be so cut, that the grains run parallel to the length. 
 
Timber Sizes 

 
Timber sold in the market is in various sizes and shapes. The following are the common 
shapes and sizes. 
a. Log ‐ The trunk of the tree which is free from branches.   
b. Balk ‐ The log, sawn to have roughly square cross section.  
 
c. Post ‐ A timber piece, round or square in cross section, having its diameter or side 

from 175 to 300mm.  
 
d. Plank ‐ A sawn timber piece, with more than 275 mm in width, 50 to 150 mm in 

thickness and 2.5 to 6.5 meters in length.   
e. Board ‐ A sawn timber piece, below 175 mm in width and 30 to 50 mm in thickness.  
 
f. Reapers‐ Sawn timber pieces of assorted and non‐standard sizes, which do not confirm to 

the above shapes and sizes.  

 

Classification of Timber 

 

Wood suitable for construction and other engineering purposes is called timber. Woods in 
general are divided into two broad categories: Soft woods and Hard woods. 

 

Soft woods are obtained from conifers, kair, deodar, chir, walnut and seemal. Woods obtained 

from teak, sal, oak, shisham, beach, ash mango, neem and babul are known as hard wood, but 

it is highly durable. 

 
Another classification of woods is based on the name of the trees like teak, babul, shisham, 
neem, kair, chir, etc. 

 

 

Seasoning of Wood 
 
A newly felled tree contains considerable moisture content. If this is not removed, the timber 

is likely to wrap, shrink, crack or decay. Seasoning is the art of extracting the moisture 
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content under controlled conditions, at a uniform rate, from all the parts of the timber. Only 

seasoned wood should be used for all carpentry works. Seasoning makes the wood resilient 

and lighter. Further, it ensures that the wood will not distort after it is made into an object. 
 
Characteristics of Good Timber 
 
The good timber must possess the following characteristics 

 

a. It should have minimum moisture content, i.e., the timber should be well seasoned.   
b. The grains of wood should be straight and long.   
c. It must retain its straightness after seasoning.   
d. It should produce near metallic sound on hammering.   
e. It should be free from knots or cracks.   
f. It should be of uniform color, throughout the part of the wood.   
g. It should respond well to the finishing and polishing operations.   
h. During driving the nails and screw, it should not split easily.  

 

Marking and Measuring Tools: 

 

Accurate marking and measurement is very essential in carpentry work, to produce parts to 

exact size. To transfer dimensions onto the work; the following are the marking and 

measuring tools that are required in a carpentry shop. 
 
Steel Rule and Steel Tape 

 

Steel rule is a simple measuring instrument consisting of a long, thin metal strip with a 

marked scale of unit divisions. It is an important tool for linear measurement. Steel tape is 

used for large measurements, such as marking on boards and checking the overall dimensions 

of the work. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig: Steel Rule and Steel Tape 

Marking Gauge 

 

It is a tool used to mark lines parallel to the edge of a wooden piece. It consists of a square 

wooden stem with a sliding wooden stock (head) on it. On the stem is fitted a marking pin, 

made of steel. The stock is set at any desired distance from the marking point and fixed in 

position by a screw. It must be ensured that the marking pin projects through the stem, about 

3 mm and the end are sharp enough to make a very fine line. A mortise gauge consists of two 
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pins. In this, it is possible to adjust the distance between the pins, to draw two parallel lines 

on the stock. 
 
 
 
 
 
 
 
 
 
 

 

Marking gauge Mortise gauge 
 

Fig: Marking Gauges 
 

Try ‐ Square 

 

It is used for marking and testing the squareness and straightness of planed surfaces. It 

consists of a steel blade, fitted in a cast iron stock. It is also used for checking the planed 

surfaces for flatness. Its size varies from 150 to 300 mm, according to the length of the blade. 

It is less accurate when compared to the try‐square used in the fitting shop. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square 

Compass and Divider 
Compass and divider, are used for marking arcs and circles on the planed surfaces of the 
wood (refer fig in next page). 

 

Scriber or Marking Knife 
It is used for marking on timber. It is made of steel having one end pointed and the other end 
formed into a sharp cutting edge (refer Fig. in next page). 

Bevel Square 

It is used for laying‐out and checking angles. The blade of the bevel is adjustable and may be 

held in place by a thumb screw. After it is set to the desired angle, it can be used in much the 

same way as a try‐square. A good way to set it to the required angle is to mark the angle on a 

surface and then adjust the blade to fit the angle 
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Fig: Compass and Divider Fig: Scriber and Bevel Square 
 
 
Holding Tools: 
 
Carpenter's Vice 

 

It is used as a work holding device in a carpenter shop. Its one jaw is fixed to the side of the 

table while the other is movable by means of a screw and a handle. The Carpenter's vice jaws 

are lined with hard wooden' faces 
 
 
 
 
 
 
 
 
 
 
Fig: Carpenters Vice Fig: C‐Clamp 

C‐Clamp 

It is used for holding small works (see figure above) 
 
Bar Cramp 
It is made of steel bar of T‐section, with malleable iron fittings and a steel screw. It is used 

for holding wide works such as frames or tops. 
 
Planing Tools: 

 

Planing is the operation used to produce flat surfaces on wood. A plane is a hand tool used 

for this purpose. The cutting blade used in a plane is very similar to a chisel. The blade of a 

plane is fitted in a wooden or metallic block, at an angle. 
 
 

 

 

Types of Planes: 
 
Jack Plane 

 

It is the most commonly used general purpose plane. It is about 35 cm long. The cutting iron 

(blade) should have a cutting edge of slight curvature. It is used for quick removal of material 

on rough work and is also used in oblique planning. 
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Smoothing Plane 

 

It is used for finishing work and hence, the blade should have a straight cutting edge. It is 

about 20 to 25 cm long. Being short, it can follow even the slight depressions in the stock, 

better than the jack plane. It is used after using the jack plane. 
 
Rebate Plane 

 
It is used for making a rebate. A rebate is a recess along the edge of a piece of wood, which 
is generally used for positioning glass in frames and doors. 
 
Plough Plane 
It is used to cut grooves, which are used to fix panels in a door. The following figure shows 
the various types of planes mentioned above. 
 
 
 

 

 

 

 

 

Cutting Tools: 

Saws 
A saw is used to cut wood into pieces. There are different types of saws, designed to suit 
different purposes. A saw is specified by the length of its toothed edge. 

Types of Saws: 

Cross‐Cut Saw or Hand Saw 

It is used to cut across the grains of the stock. The teeth are so set that the saw kerf will be 

wider than the blade thickness. This allows the blade to move freely in the cut, without 

sticking 

Rip Saw 
It is used for cutting the stock along the grains. The cutting edge of this saw makes a steeper 

angle, i.e., about 60° whereas that of crosscut saw makes an angle of 45° with the surface of 

the stock. 

Tenon Saw 
It is used for cutting the stock either along or across the grains. It is used for cutting tenons 

and in fine cabinet work. However, it is used for small and thin cuts. The blade of this saw is 

very thin and so it is stiffened with a thick back steel strip. Hence, this is sometimes called as 

back‐saw. In this, the teeth are shaped like those of cross‐cut saw. 

Compass Saw 
It has a narrow, longer and stronger tapering blade, which is used for heavy works . It is 

mostly used in radius cutting. The blade of this saw is fitted with an open type wooden 

handle. 
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Fig: Types of Saws 

Chisels: 

 

Chisels are used for cutting and shaping wood accurately. Wood chisels are made in various 

blade widths, ranging from 3 to 50 mm. They are also made in different blade lengths. Most 

of the wood chisels are made into tang type, having a steel shank which fits inside the handle. 

These are made of forged steel or tool steel blades. 
 
 
 

 

 

Fig: Types of Chisels 
 
Types of Chisels: 
 

Firmer Chisel 
The word 'firmer' means 'stronger' and hence firmer chisel is stronger than other 

chisels. It is a general purpose chisel and is used either by hand pressure or by a mallet. The 

blade of a firmer chisel is flat, as shown in figure. 
 
Dovetail Chisel 
It has a blade with a beveled back, as shown in Figure, due to which it can enter sharp 

comers for finishing, as in dovetail joints. 
 
Mortise Chisel 

It is used for cutting mortises and chipping inside holes, etc. The cross‐section of the 

mortise chisel is proportioned to withstand heavy blows during mortising. Further, the 

cross‐section is made stronger near the shank.. 
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Viva Questions 

 

Question: Name the commonly available shapes of timber in the market. 

Question: What is the sequence of operations in carpentry? 
 
Question: What is the difference between marking gauge and marking knife? 

Question: What is the difference C-clamp and bar cramp? 
 
Question: What for a plane is used in a carpentry shop? 

Question: Classify the planning tools. 
 
Question: Classify the chisels and their applications. 

Question: Name the tools used for pulling nails. 
 
Question: Name the various joinery materials used in carpentry. 

Question: Name the various types of joints. 
 
Question: Name some holding, marking, measuring, cutting, planning and finishing tools. 
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3.TIN SMITHY 

INTRODUCTION  

Tin smithy deals with the production of components in a wide variety of shapes and 

sizes from a sheet of metal with the aid hand or machines. For example many Engineering 

and house hold articles such as hoppers, guards covers, boxes and cans, funnels and ducts etc. 

are made from a flat sheet of metal. 

 

Sheet Metals Used in Metal Work: 

 

A wide variety of metals, in the form of sheet are used in sheet metal workshop. The most 
commonly used are explained below. 
 
Galvanized Iron (G.I.) Sheet 

 

It is a sheet of soft steel coated with zinc. I sheet is one of the least expensive metals used in 

sheet metal shop. It is used for making pans, buckets, gutters, tanks, boxes etc. Generally GI 

products are very suitable for corrosive environment because zinc coating protects the iron 

form corrosion. 
 
Copper 

 

It has reddish color and is used for water pipes, roofing, gutters and other parts of the 

building. Copper products are used where thermal resistance is the criterion along with 

corrosion resistance. But copper is somewhat expensive. 
 
Tin Plate 

 
Tin plate is the iron or steel coated with pure tin. It has bright silvery appearance and is used 
for containers, dairy equipments, furnace fittings, cans, trays and pans. 
 
Stainless Steel 

 

The 18-8 type steel is used in sheet metal work from the available different type of stainless 

steel. The products like food containers, dairy equipments and kitchen wares are prepare from 

18-8 steel. 
 
Black Iron 

 
It is an uncoated sheet of metal with bluish appearance. The black iron sheet is used for the 
products, which are having no restrictions on painting after its preparation. 
 
 
 

 

Aluminium 

 
It is an uncoated sheet of metal with bluish appearance. The black iron sheet is used for the 
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products, which are having no restrictions on painting after its preparation. 
 
Tools and Equipments: 

 
Most of the tools that are used in fitting are also used in sheet metal work. The additional 
tools specially used in sheet metal work are described below. 

 

Steel Rule 

 
Steel rule is a simple measuring instrument consisting of a long, thin metal strip with a 
marked scale of unit divisions. It is an important tool for linear measurement. 
 
 
 
 
 
 
 
 

 

Fig: Steel Rule 
 
Try Square 

 

It is measuring and marking tool for 900 angle .In practice, it is used for checking the 

squareness of many types of small works when extreme accuracy is not required .The blade 

of the Try square is made of hardened steel and the stock of cast Iron or steel. The size of the 

Try square is specified by the length of the blade. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Try Square 
 
Compass and Divider 

 
Compass and divider, are used for marking arcs and circles on the planed surfaces of the 
GI sheet. 

Snips: 
Snips are hand shears varying in length from 200mm to 600mm. The 250 mm length 

is the commonly used one. 
 
Types of Snips: 
 
Straight snip 

 
It has a straight blade and is used for cutting along straight lines and for trimming the edges. 
The straight snip and its usage is shown in figure below: 
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Fig: Straight Snip 
 
Bent or Curved Snip 

 

It is having curved blade and is used for cutting circles and irregular shapes. It is also used for 

trimming the cylindrical edges. The curved snip and its usage is shown in figure below: 
 
 
 
 
 
 
 

 

Fig: Bent or Curved Snip 
 
 
 
Double Snip 

 
Double shears are used for cutting thin cylinders, stove pipes and for cutting holes and light 
gauge metals. The double cut snip is shown in figure below: 
 
 
 
 
 
 
 

 

Fig: Double Snip 
 
Bench Shear 

 

In this type of hand cutting machine, the sheet is cut by shearing action. The force is applied 

through compound lever. The machine is able to cut the sheet metal upto 2 mm thick. 

 
The bench shear also consists of chopping hole in the chopping blade which can shear a mild 
steel rod upto 10 mm diameter. The below figure represents the schematic diagram of bench 
shear. 
 
 
 
 
 
 
 
 
 
 



DEPARTMENT OF MECHANICAL ENGINEERING                 ENGINEERING WORKSHOP      

 

MRCET                         EAMCET CODE:  MLRD                   www.mrcet.ac.in                                     29 

 

Fig: Bench Shear 

Stakes: 

Stakes are supporting tools used in sheet metal work. These are used to form, seam, bend or 

rivet the sheet metal objects. Stakes are made of wrought iron, faced with steel. Its working 

face well machined and polished to prevent harmful effect to sheet while doing the 

hammering process. 

Types of Stakes: 

 

Funnel Stake 
It is used for forming conical shapes and for making wire rings. The below figure shows the 
line diagram of funnel stake: 
 
Half Moon Stake 

 
It is used for folding edges of cylindrical shaped articles. The half moon stake is shown in 
figure below: 
 
Beak Horn Stake 

 
It is used for shaping round, square surfaces, bending edges, and making corners. The beak 
horn stake is shown in figure below: 
 
 
 
 
 
 

 
It is used for forming or seaming funnels. The below figure represents the blow horn stake: 
 
 
 
Conductor Stake 
It is used for forming pipes and cylindrical pieces. The conductor stake is shown in figure 
below: 
 
Hatchet Stake 

 
It has a horizontal sharp straight edge and is used for making straight, sharp bends and 
folding edges. The schematic representation of hatchet stake is shown in figure below: 
 
 
 
 
 
 
 

Fig: Hatchet Stake                                             Fig: Setting Hammer  

                               

Hammers and Mallets: 

 
Hammers and mallets are used to apply moderate forces gently in the processes accompanied 
in tinsmithy such as forming and bending. 
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Types of Hammers and Mallets: 

Setting Hammer 
It has a square, flat face and its peen is tapered on one side. It is used for setting down the 
edges for making a double seam. The below figure represents the setting hammer: 
 
Riveting Hammer 
It has a square slightly curved face and its peen is tapered. It is used for riveting. The riveting 
hammer is represented in figure below: 
 
 
 
 
 
 
 

 

Fig: Riveting Hammer 
 
Mallet: 

 
It is generally made of wood or plastic. It is used whenever slight blows are required. 
Wooden hammer (mallet) is most commonly used because it does not damage the work 
surface. The simple mallet used in tinsmithy is shown in figure below: 
 
 
 
 
 
 
 

Fig: Mallet 
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4.HOUSE WIRING 

INTRODUCTION  

Power is supplied to domesticate installations through a phase and neutral, 

forming a single phase AC 230 v to wire system. For individual establishment 

power is supplied through three phase two wire system. To give 440V, the neutral 

is earthed at to the domestic utilities; power is fed to kilo watt meter and then to 

distributes power along several circuits. It also protects these circuits from over 

load by safety devices like fuses or circuit breakers. 

ELEMENTS OF HOUSE WIRING: 

1. Fuses and circuit breakers  

2. Electric switch  

3. Plug  

4. Socket out let  

5. Lamp holder  

6. Main switch  

7. Incandesant tight 

 

 

WIRING METHOD: A circuit is path along which the electric current flows 

from negative side of power source to positive side. 

 

 

 

 

 

 

 

 

COMMON HOUSE WIRING REPAIRS: 

1. Replacing a fuse  
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2. Resulting a circuit beaker  

3. Resulting a switch or an out let  

4. Repair of house hold appliances 

 

 

PRECAUTIONS: 

1. Ensure that the insulation of wire reaches up to accessory  

2. Do not over tighten the screw  

3. Ensure that the base wire is not touching any part of accessory. 

 

RULERS OF WIRING: 

1. Every fitting or appliances must also be controlled by a switch. 

 

2. The switch should be on the line conductor  

3. Every sub-circuit must have a separate fuse. 

 

All the metals covering frames etc. should be earthed. 

Wires and Wire Sizes: 

 

A wire is defined asa bare or an insulated conductor consisting of one or 
several strands. An insulated wire consists of a conductor with insulating material 
made of vulcanized India rubber (VIR) or polyvinylchloride (PVC). The wire may 
consist o f one or several twisted strands. A multi core conductor consists of several 
cores insulated from one another and enclosed in a common sheathing (fig.3.10). 

 

Wires ize sare specified by diameter of the wire, using a stand ard wire 
gauge (SWG), which also gives an ideao f the current carrying capacity. 
Thespecification consist so fb ot htheno. Of strandsand the diameter of each wire in 
it. Forexample, the specification, (i)silk wire14/36 indicates14strands of 36SWG 
each and 

 

(ii )3/18 PVC indicates 3 strands of 18SWG each. 

 

Safe Practices 

 
1. When closing the electric switch, always grasp the switch by the insulated handle  

 

2. Do not run too many electrical items from one point  
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3. Use fuses in the circuit breakers of proper capacity, so as to interrupt the current before it 
becomes dangerous  

 

4. Disconnect the units to be repaired, free from power supply and make sure that they might 
not be energized while the repair work continues  

 

5. Do not pour water to put off fires in electric wires and electric equipment. You will be 

subjected to electric shock or you will be electrocuted use sand to put off fires in electric 

items.  

 

6. Whenever there is power failure put-off the power supply to all equipments in order to 
prevent spontaneous recovery  
 
7. Never remove a plug from an outlet by pulling the cord. Always pull by the plug.  

 

8. Never work on electric wires when the power is on  

 
9. Never work with bare feet  

 

10. While testing, always keep one hand in your pocket. If the hands are in contact with a 
circuit, a current will flow across your body and is more dangerous.  

 

11. Electricity has no respect for ignorance. Do not apply voltage or turn-on any device until 
it has been properly checked.  

 
12. Check the earth connection before switching-on portable equipment  

 

13. Before replacing the blown fuse, always switch-off the main switch  
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Viva Questions 

 
Question: Define electric wiring. 
 
Question: Name the safety devices used to protect the electric circuits from overload. 
Question: Differentiate between a fuse and a circuit breaker. 
 
Question: What for a lamp holder is used in an electric circuit? 

Question: Name the types of lamp holders available in the market. 

Question: What for a ceiling rose is used? 
 
Question: What is meant by an electric circuit? Question: 

Name the three types of electrical circuits. Question: Name 

the motor driven household appliances. 
 
Question: What are the precautions to be taken, while connecting the wires with electrical 

accessories? 
 
Question: What is the difference emergency lamp and indicator lamp? 
Question: Define the term earthing or grounding.  
Question: Name the different methods of earthing. 
 
Question: How much is the power supply required for house wiring? 

Question: What is the purpose of choke in the fluorescent tube circuit? 

Question: What is the purpose of starter in the fluorescent tube circuit? 
 
Question: What is the reason of using parallel connections usually in the house wiring? 
Question: What is the reason of getting less brilliancy of each bulb in series connections? 
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5. WELDING 

INTRODUCTION 

Welding is a process for joining two similar or dissimilar metals by fusion. It 

joins different metals/alloys, with or without the application of pressure and with or 

without the use of filler metal. The fusion of metal takes place by means of heat. The 

heat may be generated either from combustion of gases, electric arc, electric 

resistance or by chemical reaction. 

Welding provides a permanent joint but it normally affects the metallurgy of the 

components. It is therefore usually accompanied by post weld heat treatment for most of the 

critical components. The welding is widely used as a fabrication and repairing process in 

industries. Some of the typical applications of welding include the fabrication of ships, 

pressure vessels, automobile bodies, off-shore platform, bridges, welded pipes, sealing of 

nuclear fuel and explosives, etc. 
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welding joints such as base metal, fusion zone, weld face, root face, root opening toe 

and root are depicted in Figure. 

Edge preparations 

For welding the edges of joining surfaces of metals are prepared first. Different edge 

preparations may be used for welding butt joints, which are given in Figure. 

Welding joints 

Some common welding joints are shown in Figure. Welding joints are of generally of 

two major kinds namely lap joint and butt joint. The main types are described as 

under. 

1. Lap weld joint 

Single-Lap Joint 

This joint, made by overlapping the edges 

of the plate, is not recommended for most 

work. The single lap has very little 

resistance to bending. It can be used 

satisfactorily for joining two cylinders 

that fit inside one another. 

Double-Lap Joint 

This is stronger than the single-lap joint 

but has the disadvantage that it requires 

twice as much welding. 

Tee Fillet Weld 

This type of joint, although widely used, should not be employed if an alternative design is 

possible. 
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2. Butt weld joint 

a. Single-V Butt Weld  

It is used for plates up to 15.8 mm thick. The angle of the vee depends upon the 

technique being used, the plates being spaced approximately 3.2 mm. 

 

b. Double-V Butt Weld  

It is used for plates over 13 mm thick when the welding can be performed on 

both sides of the plate. The top vee angle is either 60° or 80°, while the bottom 

angle is 80°, depending on the technique being used. 

Welding Positions 

As shown in Fig there are four types of welding positions, which are given as: 

 Flat or down hand position 

 Horizontal position 

 Vertical position 

 Over head position 

 

 

 

Flat or Down-hand Welding Position 

The flat position or down hand position is one in which the welding is performed 

from the upper side of the joint and the face of the weld is approximately horizontal. 

Horizontal Welding Position 

In horizontal position, the plane of the workpiece is vertical and the deposited weld head is 

horizontal. 

This position of welding is most commonly used in welding vessels and reservoirs. 

Vertical Welding Position 

In vertical position, the plane of the work-piece is vertical and the weld is 

deposited upon a vertical surface. It is difficult to produce satisfactory welds in this 

position due to the effect of the force of gravity on the molten metal. 

The overhead position is probably even more difficult to weld than the 

vertical position. Here the pull of gravity against the molten metal is much greater. 
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ARC WELDING PROCESSES 

The process, in which an electric arc between an electrode and a work-piece or 

between two electrodes is utilized to weld base metals, is called an arc welding 

process. The basic principle of arc welding is shown in Figure1. However the basic 

elements involved in arc welding process are shown in Figure2. Most of these 

processes use some shielding gas while others employ coatings or fluxes to prevent 

the weld pool from the surrounding atmosphere. 

1. Switch box 

2. Secondary terminals 

3. Welding machine 

4. Current reading scale 

5. Current regulating hand wheel 

6. Aapron 

7. Asbestos hand gloves 

8. Channel for cable protection 

9. Welding cable 

10. Chipping hammer 

11. Wire brush 

12. Earth cable 

13. Welding table(Metallic) 

14. Job  

Fig2.The basic elements of arc welding 

Arc welding equipment 

Arc welding equipment, setup and related tools and accessories are shown 

in Figure. However some common tools of arc welding are shown separately 

through Figure. Few of the important components of arc welding setup are 

described as under. 

 

Arc welding power source 

Both direct current (DC) and alternating current (AC) are used for electric arc 

welding, each having its particular applications. DC welding supply is usually 

obtained from generators driven by electric motor or if no electricity is available by 
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internal combustion engines. For AC welding supply, transformers are predominantly 

used for almost all Arc-welding where mains electricity supply is available. They 

have to step down the usual supply voltage (200-400 volts) to the normal open circuit 

welding voltage (50-90 volts). The following factors influence the selection of a 

power source: 

 

a. Type of electrodes to be used and metals to be welded  

b. Available power source (AC or DC)  

c. Required output  

d. Duty cycle  

e. Efficiency  

f. Initial costs and running costs  

g. Available floor space 

 

h. Versatility of equipment  

Welding cables 

Welding cables are required for conduction of current from the power source 

through the electrode holder, the arc, the work piece and back to the welding power 

source. These are insulated copper or aluminum cables. 

1.  Electrode holder 

Electrode holder is used for holding the electrode 

manually and conducting current to it. These are 

usually matched to the size of the lead, which in turn 

matched to the the amperage output of the arc welder. 

Electrode holders are available in sizes that range from     

150 to 500 Amps. 

  

                                                                                                    Fig:  Electrode holder 
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2. Welding Electrodes 

An electrode is a piece of wire or a rod of a metal or alloy, with or without coatings. 

An arc is set up between electrode and workpiece. Welding electrodes are classified 

into following types- 

(i) Consumable Electrodes  

(a) Bare Electrodes  

(b) Coated Electrodes  

(ii) Non-consumable Electrodes  

(a) Carbon or Graphite Electrodes  

(b) Tungsten Electrodes 

Consumable electrode is made of different metals and their alloys. The end of 

this electrode starts melting when arc is struck between the electrode and 

workpiece. Thus consumable electrode itself acts as a filler metal. Bare electrodes 

consist of a metal or alloy wire without any flux coating on them. Coated 

electrodes have flux coating which starts melting as soon as an electric arc is 

struck. This coating on melting performs many functions like prevention of joint 

from atmospheric contamination, arc stabilizers etc. 

Non-consumable electrodes are made up of high melting point materials like 

carbon, pure tungsten or alloy tungsten etc. These electrodes do not melt away 

during welding. But practically, the electrode length goes on decreasing with the 

passage of time, because of oxidation and vaporization of the electrode material 

during welding. The materials of non-consumable electrodes are usually copper 

coated carbon or graphite, pure tungsten, thoriated or zirconiated tungsten. 

5. Hand Screen 

Hand screen used for protection of eyes and supervision of weld bead. 

6. Chipping hammer 

Chipping Hammer is used to remove the slag by striking. 

7. Wire brush 

Wire brush is used to clean the surface to be weld. 
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Protective clothing 

Operator wears the protective clothing such as apron to keep away the exposure of 

direct heat to the body. 

Safety Recommendations for ARC Welding 

The beginner in the field of arc welding must go through and become familiar with 

these general safety recommendations which are given as under. 

 

1. The body or the frame of the welding machine shall be efficiently earthed. Pipe 

lines containing gases or inflammable liquids or conduits carrying electrical 

conductors shall not be used for a ground return circuit All earth connections 

shall be mechanically strong and electrically adequate for the required current.  

2. Welding arc in addition to being very is a source of infra-red and ultra-violet 

light also; consequently the operator must use either helmet or a hand-shield 

fitted with a special filter glass to protect eyes  

3. Excess ultra-violet light can cause an effect similar to sunburn on the skin of the welder  

4. The welder’s body and clothing are protected from radiation and burns caused 

by sparks and flying globules of molten metal with the help of the following:  

5. Gloves protect the hands of a welder.  

6. Leather or asbestos apron is very useful to protect welder’s clothes and his 

trunk and thighs while seated he is doing welding.  

7. For overhead welding, some form of protection for the head is required  

8. Leather skull cap or peaked cap will do the needful.  

9. Leather jackets and 1ather leggings are also available as clothes for body protection.  

10. Welding equipment shall be inspected periodically and maintained in safe 

working order at all times.  

11. Arc welding machines should be of suitable quality.  

12. All parts of welding set shall be suitably enclosed and protected to meet the 

usual service conditions. 
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6.BLACKSMITHY 

INTRODUCTION 

Black smithy or Forging is an 

oldest shaping process used for the 

producing small articles for which accuracy 

in size is not so important. The parts are 

shaped by heating them in an open fire or 

hearth by the blacksmith and shaping them 

through applying compressive forces using 

hammer. 

 

Thus forging is defined as the plastic deformation of metals at elevated 

temperatures into a predetermined size or shape using compressive forces exerted 

through some means of hand hammers, small power hammers, die, press or upsetting 

machine. It consists essentially of changing or altering the shape and section of metal 

by hammering at a temperature of about 980°C, at which the metal is entirely plastic 

and can be easily deformed or shaped under pressure. The shop in which the various 

forging operations are carried out is known as the smithy or smith’s shop. 

 

Hand forging process is also known as black-smithy work which is 

commonly employed for production of small articles using hammers on heated jobs. 

It is a manual controlled process even though some machinery such as power 

hammers can also be sometimes used. Black-smithy is, therefore, a process by which 

metal may be heated and shaped to its requirements by the use of blacksmith tools 

either by hand or power hammer. 

 

Forging by machine involves the use of forging dies and is generally 

employed for mass-production of accurate articles. In drop forging, closed 

impression dies are used and there is drastic flow of metal in the dies due to repeated 

blow or impact which compels the plastic metal to conform to the shape of the dies. 

Applications of forging  

Almost all metals and alloys can be forged. The low and medium carbon steels are 

readily hot forged without difficulty, but the high-carbon and alloy steels are more difficult to 

forge and require greater care. Forging is generally carried out on carbon alloy steels, 

wrought iron, copper-base alloys, aluminum alloys, and magnesium alloys. Stainless steels, 

nickel-based super alloys, and titanium are forged especially for aerospace uses. 
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COMMON HAND FORGING TOOLS 

For carrying out forging operations manually, certain common hand forging tools are 

employed. These are also called blacksmith’s tools, for a blacksmith is one who works on the 

forging of metals in their hot state. The main hand forging tools are as under 

Tongs 

The tongs are generally used for 

holding work while doing a forging 

operation. Various kinds of tongs are 

shown in Figure. 

 

a) Straight-lip fluted tongs are commonly used for holding square, circular and 

hexagonal bar stock.  

b) Rivet or ring tongs are widely used for holding bolts, rivets and other work of circular 

section.  

c) Flat tongs are used for mainly for holding work of rectangular section.  

d) Gad tongs are used for holding general pick-up work, either straight or tapered. 

 

Flatter 

Flatter is shown in Fig. It is commonly used in forging shop to give smoothness and 

accuracy to articles which have already been shaped by fullers and swages. 

Swage 

 

Swage is used for forging work which has to be reduced or finished to round, square 

or hexagonal form. It is made with half grooves of dimensions to suit the work being 

reduced. It consists of two parts, the top part having a handle and the bottom part 

having a square shank which fits in the hardie hole on the anvil face. 

 

Fuller 

 

Fuller is used in forging shop for necking down a forgeable job. It is 

made in top and bottom tools as in the case of swages. Fuller is 

made in various shapes and sizes according to needs, the size 

denoting the width of the fuller edge 

 

Punch 
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Punch is used in forging shop for making holes in metal part when it is at forging 

heat 

 

 

 

 

 

 

 

 

 

Chisels 

Chisels are used for cutting metals and for nicking prior to breaking. They may be 

hot or cold depending on whether the metal to be cut is hot or cold. A hot chisel 

generally used inforging shop is shown in Fig.  The main difference between the two 

is in the edge. The edge of a cold chisel is hardened and tempered with an angle of 

about 60°, whilst the edge of a hot chisel is 30° and the hardening is not necessary. 

The edge is made slightly rounded for better cutting action. 

Hand hammers 

There are two major kinds of hammers are used in hand forging: 

 

a. The hand hammer used by the smith himself and 
 

b. The sledge hammer used by the striker. 

Hand hammers may further be classified as (a) ball 

peen hammer, (b) straight peen hammer, and (c) 

cross peen hammer. 

Sledge hammers may further be classified as (a) 

Double face hammer, (b) straight peen hammer, and 

(c) cross peen hammer. 

 

Hammer heads are made of cast steel and, their ends are hardened and tempered. The 

striking face is made slightly convex. The weight of a hand hammer varies from 

about 0.5 to 2 kg whereas the weight of a sledge hammer varies from 4 to 10 kg 
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Set hammer 

A set hammer generally used in forging shop is shown in FigIt is used for finishing 

corners in shouldered work where the flatter would be inconvenient. It is also used 

for drawing out the gorging job. 

Anvil 

An anvil is a most commonly tool used in forging shop which is shown in. It acts as a 

support for blacksmith’s work during hammering. The body of the anvil is made of 

mild steel with a tool steel face welded on the body, but the beak or horn used for 

bending curves is not steel faced. The round hole in the anvil called pritchel hole is 

generally used for bending rods of small diameter, and as a die for hot punching 

operations. The square or hardie hole is used for holding square shanks of various 

fittings. Anvils in forging shop may vary up to about 100 to 150 kg and they should 

always stand with the top face about 0.75 mt. from the floor. This height may be 

attained by resting the anvil on a wooden or cast iron base in the forging shop. 

Swage block 

Swage block generally used in forging shop is shown in figure. It is mainly used for 

heading, bending, squaring, sizing, and forming operations on forging jobs. It is 0.25 

mt. or even more wide. It may be used either flat or edgewise in its stand. 

FORGING OPERATIONS:  

The following are the basic operations that may be performed by hand forging: 

1. Drawing-down: 

Drawing is the process of stretching the stock while reducing its cross-section 

locally. Forging the tapered end of a cold is an example of drawing operation. 

2. Upsetting: 

It is a process of increasing the area of cross-section of a metal piece locally, 

with a corresponding reduction in length. In this, only the portion to be upset is 

heated to forging temperature and the work is then struck at the end with a hammer. 

Hammering is done by the smith (student) himself, if the job is small, or by his 

helper, in case of big jobs, when heavy blows are required with a sledge hammer. 

 

3. Fullering 

Fullers are used for necking down a piece of work, the reduction often 

serving as the starting point for drawing. Fullers are made of high carbon steel in two 

parts, called the top and bottom fullers. The bottom tool fits in the hardie hole of the 

anvil. Fuller size denotes the width of the fuller edge. 
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4. Flattering: 

 

Flatters are the tools that are made with a perfectly flat face of about 7.5 cm 

square. These are used for finishing flat surfaces. A flatter of small size is known as 

set-hammer and is used for finishing near corners and in confined spaces. 

5. Swaging: 

Swages like fullers are also made of high carbon steel and are made in two parts 

called the top and swages. These are used to reduce and finish to round, square or 

hexagonal forms. For this, the swages are made with half grooves of dimensions to 

suit the work. 

6. Bending: 

Bending of bars, flats, etc., is done to produce different types of bent shapes 

such as angles, ovals, circles etc. Sharp bends as well as round bends may be made 

on the anvil, by choosing the appropriate place on it for the purpose. 

7. Twisting: 

 It is also one form of bending. Sometimes, it is done to increase the rigidity of 

the work piece. Small piece may be twisted by heating and clamping a pair of tongs on each 

end of the section to be twisted and applying a turning moment. 

Larger pieces may be clamped in a leg vice and twisted with a pair of tongs or a 

monkey wrench. However, for uniform twist, it must be noted that the complete 

twisting operation must be performed in one heating. 

8. Cutting (Hot and Cold Chisels): 

Chisels are used to cut metals, either in hot or cold state. The cold chisel is similar to 

fitter’s chisel, except that it is longer and has a handle. A hot chisel is used for cutting hot 

metal and its cutting edge is long and slender when compared to cold chisel. These chisels are 

made of tool steel, hardened and tempered. 
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8. FOUNDARY 

 
INTRODUCTION 

 

Foundry practice deals with the process of making castings in molds, formed in either sand or 

some other material. The process involves the operations of pattern making, sand preparation, 

molding, melting of metals, pouring in molds, cooling, shake-out, heat treatment, finishing, 

and inspection. 

 

Pattern 

 

Pattern is the principal tool during the casting process. It may be defined as a model of 

anything, so constructed that it may be used for forming an impression called would in damp 

sand or other suitable material. 

 

When this mold is filled with molten metal and the metal is allowed to solidify it forms a 

reproduction of the pattern and is known as casting. The process of making pattern is known 

as pattern making. 

 

Mold 

 

Mold is cavity formed by the pattern. It is similar in shape and size to that of the actual 

casting plus some allowances for shrinkage, machining etc. Molds are classified as temporary 

and permanent. Temporary molds are made of refractory sand and other binding materials 

and may be produced either through hand molding or machine molding. 

 

Molding Sand 

 

Sand is the principal material used in foundry. The principal ingredients of molding sands 

are: Silica sand, clay, moisture, and miscellaneous materials. Silica sand withstands very high 

temperatures and doesn’t react with the molten metal. 

 

Clay imparts the necessary bonding strength to the molding sand. 

 
Moisture in requisite amount furnishes the bonding action of clay. 

 

Miscellaneous materials that are formed in addition to silica and clay penetrates the mixture 
and forms a microfilm which coats the surface flake shaped clay particles. 

 

Natural molding sand is available in river beds or dug from pits. They possess an appreciable 
amount of clay and are used as received with addition of water. 

 

Synthetic sands are prepared by adding clay, water and other materials to silica sand so that 

desired strength and bonding properties are achieved which are not possessed by natural 

sands. 
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Properties of Molding Sand: 

 

The essential requirement of good molding sand is that it should produce sound castings 

which are free from defects. For producing sound castings, molding sand or mold should 

possess the following properties; to quote a few: 

 

Porosity or Permeability 

 

When molten metal is poured into a mold, gases and steam are passed through it. If they are 
not removed, casting defects such as blow holes will be formed. 

 

Flowability 

 

Flowability of molding sand refers to its ability to its ability, under externally applied forces 

(ramming), into deeper sections of the pattern and uniformly fill the flask. Flowability 

increases as clay and water content increase. 

 

Collapsibility 

 

Collapsibility is the property of sand that permits it to collapse (break) easily during its 

knockout from the castings. This property is particularly important for cores. This property 

depends on amount of the sand, clay and type of binder used. 

 

Adhesiveness 

 

Adhesiveness is the ability of a molding sand to stick on the surface of molding boxes. It is 

due to this property that the sand mass can be successfully held in a molding box and it does 

not fall out of the box when it is removed. 

 

Cohesiveness or Strength 

 

This is the ability of sand particles to stick together. Insufficient strength may lead to a 
collapse in the mold or its partial destruction during conveying, turning over or closing. 

 

Refractoriness 

 

The sand must be capable of withstanding the high temperature of the molten metal without 
fusing. 
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Types of Molding Sand: 

 

Molding sands are classified according to their use into a number of varieties. These are 
described as follows: 

 

Green Sand 
It is a mixture of silica sand with 18 to 30 % clay having a total water of 6 to 8 %. 

Dry Sand 
Green sand that has been dried or baked after the mold is made is called dry sand. 

 

Loam Sand 

 

Loam sand is high in clay, as much as 50 %. 

 

Facing Sand 

 

Facing sand forms the face of the mold. It is used directly next to the surface of the pattern 

and it comes into contact with the molten metal when the mold is poured. It is made of silica 

sand and clay, without the addition of used sand. 

 

Baking Sand 

 

Baking sand or floor sand is used to backup the facing sand and fill the whole volume of the 

flask. Old repeatedly used molding sand is mainly employed for this purpose. The baking 

sand is sometimes called black sand because of the fact that old, repeatedly used molding 

sand is black in color due to the addition of coal dust and burning on coming in contact with 

molten metal. 

 

Parting Sand 

 

Parting sand is used to keep the green sand from sticking to the pattern and also to allow the 

sand on the parting surface of the cope and drag to separate without clinging. This is clean 

clay free silica sand which serves the same purpose as parting dust. 

 

Core Sand 

 

The sand used for making cores is called as core sand and sometimes it is called as oil sand. 

This is silica sand mixed with core oil which is composed of linseed oil. Resin light mineral 

oil and other binding materials. 
 
 

Pattern Materials: 
 
The selection of pattern materials depends primarily on the following factors. 

 

1. Service requirement, e.g. quantity, quality, and intricacy of casting i.e. minimum 
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thickness, desired degree of accuracy, and finish required   
2. Type of production of castings and the type of molding process  

3. Possibility of design changes   
4. Number of castings to be produced, i.e. possibility of repeat orders  

 

To be good of its kind, pattern material should be: 

 
a. Easily worked, shaped, and joined   
b. Light in weight  

 
c. Strong, hard, and durable, so that it may be resistant to wear and abrasion, corrosion, 

and to chemical action   
d. Dimensionally stable in all situations   
e. Easily available at low cost   
f. Repairable and reused   
g. Able to take good surface finish  

 

The wide variety of pattern materials which meet these characteristics are wood and wood 
products; metal and alloys; plasters; plastics and rubber; and waxes. 

 

Types of Patterns: 
 
Single Piece or Solid Pattern 
 
 
In a simple solid pattern, one side is made flat which serves as a parting surface. In this case, 

the mold cavity will be entirely in the drag, and requires the more number of manual 

operations such as cutting the gating system and repairing of the mold. The shape of the 

single piece pattern is exactly same as that of casting. Single piece patterns are inexpensive 

and best suited for limited production. 
 
 
 
 
 
 
 
 
 
 

 

Fig: Split Pattern                                                                   Fig: Single Piece Pattern 
 
 
Split pattern: 

Split pattern is made in two parts. One part producing the mold in drag and the other 

in cope. They are kept in position by dowel pins, and the split is usually arranged along the 

parting line to draw the pattern easily out of the mold before pouring of molten metal. Split 

piece patterns are used for intricate castings or castings of unusual shapes. 
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Multi Piece Pattern 
 
 
Pattern with three or more parts is used for more complex castings. This type of pattern is 

known as multi piece pattern. It requires molding box with three parts. The middle one is 

called cheek. 
 
 
Loose Piece Pattern 
 
 
Loose piece pattern is used to produce the castings having projections in the sides. Such 

design makes impossible to draw the pattern from the mold. It is therefore necessary to make 

such projection in loose piece and fastened to main pattern by means of anchor pin. 
 
 
 
 
 
 
 
 
 
 
 

Fig: Loose Piece Pattern 

Match Plate Pattern 

 

In this case, pattern in two halves is attached on opposite side of wooden or metal plate 

(match plate). Production efficiency and dimensional accuracy of castings can be generally 

improved by the use of these patterns. Several patterns for small castings (need not be same) 

can be mounted on one match plate. These are mostly used in machine molding as well as for 

producing large number of small castings by hand molding. 
 
 
 
 
 
 
 
 
 
  
 
Fig: Sweep Pattern 

                                               Fig: Match Plate Pattern 
 
 

Sweep Pattern 

 

It is not a true pattern, but a template made of wood or metal revolving around a fixed axis in 

the mold shapes the sand to the desired contour. This eliminates the need for a large three 

dimensional pattern. It is suitable for producing simple symmetrical castings such as wheels, 

rims, and bell shapes. 
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Runner: 

 

Runner is a horizontal channel that receives molten metal from the sprue base, and distributes 

to the ingates which carries metal to the mold. Runners are usually made trapezoidal in cross-

section. They are generally located in cope and ingates in the drag. This ensures that the slag 

and dross are trapped in the upper portion of runner and only molten metal enters into the 

mold. 
 
 
Runner Extension: 

 

The runner is often extended beyond the last ingate to retain inclusions and various refractory 

materials that may have been washed along the stream of molten metal. Also, it absorbs 

kinetic energy causing a smooth flow of metal into the mold cavity. 
 
Gates or Ingates: 
 
Gates or ingates are openings through which molten metal directly enters into the mold 

cavity. The gates should be designed such that the molten metal can flow steadily and quietly 

into the mold cavity. They should be easily removed from the casting after solidification. 
 
Tools and Equipment: 
 
Molding Board 
A molding board is a smooth wooden board on which the flask and pattern are placed when 
the mould is being made. The figure is shown below: 
 
 
 
 
 
 
 
 
Fig: Molding Boxes 
 

 

Molding Boxes 
Sand moulds are prepared in specially constructed boxes called flasks. The purpose of flask is 

to impart the necessary rigidity and strength to the sand in molding. They are usually made in 

two parts, held in alignment by dowel pins. The top part is called the cope and the lower part 

the drag. These flasks can be made by wood or metal depending upon the size required and 

the purpose the flask must serve. 
 
Shovel 
A shovel is used for mixing and tempering molding sand and for moving the sand from the 
pile to the flask as shown in figure below: 
 
Riddle 
A riddle sometimes called a screen consists of a circular or square wooden frame fitted with a 

standard wire mesh at the bottom as shown in figure below. It is used to remove coarse sand 

particles and other foreign material from the foundry sand. 
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Fig: Shovel                                         Fig: Riddle                                                   Fig: 

Rammers 

Rammer 

 

A hand rammer is used for packaging or ramming the sand into the mould. One of its ends, 

called the peen end, is wedge shaped and is used for packing sand in spaces, pockets and 

corners, in the early stages of ramming. The other end called the butt end, has a flat surface 

and is used for compacting the sand towards the end of molding as shown in below figure. 

Strike Edge or Strike-Off Bar 

 

It is a piece of metal or wood with straight edge as shown in below figure. It is used to 

remove excess sand from the mould after ramming, to provide a level surface 

Riser Pin 
It is a straight wooden pin used to make a hole in the cope over the mold cavity for the 

molten metal to rise-in and feed the casting to compensate the shrinkage that may take place 

during solidification. 

Sprue Pin 

 
It is a tapered wooden pin, as shown in below figure. It is used to make a hole in the cope 
through which the molten metal is poured into the mould. 
 
 
 
 
 
 
 

Fig: Sprue Pin                            Fig: Slick 
 

 

              Fig: Lifters 

Slick 

 

It is a small double ended tool having a flat on one end and a spoon on the other end as 

shown in below figure. Slicks are used for repairing and finishing small surfaces of the 

mould. 
 
Lifter 
Lifters are made of thin sections of steel of various widths and lengths with one end bent at 

right angles as shown in below figure. They are used to clean and finish the bottom and sides 

of deep, narrow openings in moulds. 
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Gate Cutter 
It is a small piece of tin plate shape as shown in below figure. This serves as a tool for cutting 
gates and runners in the mould. 
 
 
   
 
 

 

Fig: Gate Cutters                Fig: Vent Rods 

Fig: Draw Spikes 

 Vent Rod 
A vent rod or wire, as shown in below figure is used to make a series of small holes to permit 
gases to escape while the molten in being poured. 
 
Drawspike or Screw 

 

The draw spike is appointed steel rod, with a loop at one end. It is used to rap a draw patterns 

from the sand. Below figure shows two kinds of draw spikes. The draw spike is threaded on 

the end to engage metal patterns. 
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DEPARTMENT OF MECHANICAL ENGINEERING                 ENGINEERING WORKSHOP      

 

MRCET                         EAMCET CODE:  MLRD                   www.mrcet.ac.in                                     74 

 

8. PLUMBING 

Plumbing is a skilled trade of working with pipes or tubes and plumbing 

fixtures. The process is mainly used for the supply of drinking water and the 

drainage of waste water, sometimes mixed with waste floating materials in a living 

or working place. A plumber is someone who installs or repairs piping systems, 

plumbing fixtures and equipment such as valves, washbasins, water heaters, water 

closests, etc. Thus it usually refers to a system of pipes and fixtures installed in a 

building for the distribution of water and the removal of waterborne wastes. 

The latin word plumbum, means metal lead pipe, is the origin for 

developing the term plumbing. Plumbing process was originated during the ancient 

civilizations such as the greek, Roman, Persian, Indian and Chinese civilizations as 

they developed public baths and needed to provide potable water, and drainage of 

wastes carried by water. 

PIPES AND THEIR JOINTS: 

Pipes are manufactured by using different types of materials like steel, cast 

iron, galvanized iron, brass, copper, aluminum, lead, plastic, concrete, asbestos, 

etc. They are usually classified according to the material. They are also grouped as 

cast, welded, seamless, extruded, etc. For conveying large quantity of water, cast 

iron, steel or concrete pipes having large diameter are usually used. Galvanized 

iron pipes (GI pipes) are popular for medium and low pressure water supply lines. 

Plastic pipes are preferred for household uses at low pressure. Pipes are 

generally specified by their inner diameter (Nominal diameter specified in inches). 

Hence, the pipe fitting size is also based on this dimension. But for plastic pipes, 

this rule is not strictly followed because threading is not usually required for them. 

For engineering uses, along with the nominal diameter, the pipe thickness is also 

specified as light, medium or heavy. 

Types of pipe joints: 

According to the pipe material, size and application, different methods are used 

to join pipes. The most common types of pipe joints are: 

1. Screwed pipe joint – For GI Pipes  

2. Welded pipe joint – for steel, copper, aluminum and lead pipes  

3. Flanged pipe joint – for cast iron and steel pipes  

4. Soldered pipe joint – for brass and copper tubes  

5. Glued or cemented pipe joint – for PVC pipes 
 

Pipes made of iron (GI Pipes) and brass of small and medium diameters (10 mm to 

100 mm) are usually joined by screwing the pipe specials with internal or external 

threads. Welding is used to make permanent joint of medium and large diameter 
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steel pipes. Flanged pipe joints are common in medium and large diameter pipes of 

cast iron and steel, along with rubber/CAF (Compressed asbestos fibre) gaskets. 

The flanged are screwed to the pipe for smaller diameter but made integral for 

large diameters. Pipes of copper and brass are usually joined by soldering. 

PVC (poly Vinyl Chloride) pipe is the most popular choice in plastic group. It is 

rigid and uses thread and solvent weld (glue) connections. It also can be heat fused. 

PVC pipes are available in various pressure ratings for water supply, and is a very 

choice for landscape irrigation. The reasons for the popularity are the economy, no 

corrosion and easiness to work. CPVC is a different type of plastic, which has an 

extra chlorine atom in the compound, can be used for the hot water supply, and in 

industry. 

 

To join plastic pipes, gluing or cementing method is used. Solvent cement is the 

gluing material and it partially melts the surface of the plastic pipe to make the 

joint. As the glue evaporates within two minutes, a strong joint is obtained. 

Screwed pipe fittings, (pipe specials) are removable or temporary pipe connections 

which permit necessary dismantling or reassembly for the purpose of installation, 

maintenance, cleaning, repair, etc. The functions of pipe fittings can be broadly 

classified as: 

 

1. To join two or more pipe lines together  

2. To effect change in diameter or direction  

3. To close the end of a pipe line 
 

The most common types of screwed pipe fittings used in galvanized iron (GI) pipe 

lines and plastic (PVC) pipe lines are shown in Figure 1 (I to 17). A brief 

description of these fittings is given below 

 

1. Coupler (coupling): Two pipe lines of equal diameter and in axial alignment 

can be joined by a coupler (coupling). It is a short sleeve with internal thread.  

2. Reducer coupler (Reducer coupling): This is a coupler to join two pipe lines of 

different diameters in axial alignment.  

3. 90
0
 Elbow: This is a pipe special used or effecting abrupt change in direction 

through 90°. Internal threads are provided on both ends. An elbow brings twice the 
head loss than a bend.  

4. 90
0
 Reducer elbow: This is an elbow with outlet diameter less than that of inlet 

diameter It is used to join two pipe lines having different diameters and meeting at 
right angle.  
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5.Bend: This is a pipe special used to effect gradual change in direction (usually 

90°).The two ends of the bend are externally threaded. 

 

6. Return hand: This bend is used to return the direction of pipe line through 

180°.The ends are internally threaded for fitting the pipe lines.  

1. Tee: This pipe special is used to make a branch connection of same diameter to 

the main pipe line at right angle. A Tee is internally threaded and it connects three 

ends of pipes.  

8. Reducer Tee: This is a pipe special similar to Tee used to take a branch 

connection of reduced diameter from the main pipe line.  

9, Cross: This pipe special is used to take two branch connections at right angles to 

the main pipe line. The threads are provided internally, 

 

10. Close nipple: A nipple is a short straight piece of pipe with external thread on 

both ends. A close nipple is the shortest one of this category with external thread 

for the full length. They are used to join two internally threaded pipe specials and 

valves.  

11. Short nipple: A short nipple has the same shape and function of a close nipple, 

but it has a short unthreaded portion at the middle of its length for gripping.  

12. Short nipple with hexagonal grip: This nipple has an additional hexagonal nut 

shape at the middle portion for easy screwing with spanner. It is similar to an 

ordinary short nipple, except that difference.  

13. Hose nipple: A hose nipple is used to connect a hose (flexible pipe-usually 

plastic or rubber) to a pipe line. One end of the hose-nipple has a stepped taper to 

fit the hose, while other end has thread. A hexagonal nut shape is given to the 

middle portion for gripping with a spanner. 
 

14. Male plug: A male plug is used to close an internally threaded end of a pipe 

line or pipe special. It has external thread and a grip of square shape at the end.  

15. Female plug (cap): A female plug is used to close an externally thread end of a 

pipe or pipe special. It has internal thread and a grip of square shape at the end.  

16. Screwed union: II consists of three pieces as shown in the drawing. The two 

end pieces have internal threads at their ends which are connected to the pipe ends. 

The central hexagonal (or octagonal) piece (union nut) has internal thread at one 

end and a collar at the other end. After the end pieces are screwed on to the pipes, 

the central piece (union nut) is tightened to draw the end pieces together to get a 

water tight joint.  

17. Flange: This is a disc type pipe special having threaded hole at the centre for 

screwing to the externally threaded end of a pipe line. It will have holes around the 

central hole at equal angular spacing (3, 4, 6f or 8 Nos.) for joining to another 
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similar flange or flat surface using bolt or stud. Example for the use of various pipe 

fittings in pipe line is given in Figure . 
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Applications of Various pipe joints 

Valves and Meters 

Valves are used in piping systems to control or stop the flow of liquid 

or gas. The most common types of valves used in low pressure water pipe line are:                                                                                           

1. Water tap                                                          

2. Water cock  

3. Globe valve  

4. Gate valve  

5. Ball valve                                                      

6. Non-return valve  

7. Foot valve  

Water tap 

To collect water from low pressure pipe line, 

water tap (screw-down valve) is commonly 

used. Figure gives the cross section of the tap. 

Its leather or rubber faced valve disc is lifted or 

lowered by rotating the spindle. Brass or gun-

metal is the material used for the valve body 

and the size is specified by the pipe to which it 

is fitted, usually ranging from 10 mm to 25 

mm. 

Water cock 

This is the simplest and smallest form of a valve in which a 

Conical plug called cock is inserted into a conical hole having a matching taper. A 

rectangular hole is provided at the centre across the conical potion so that, in one 

position it permits flow of water as shown in Figure. A half turn of the handle will 

bring the solid portion of the cock to the water ways preventing the flow. Cocks are 

used for low rate of water flow' or for tapping 

Globe valve 

Globe valves are used as control valves in fluid (gas and liquid) pipe lines. Figure 

shows the simplest and smallest type of globe valve used in water pipe lines. 

Basically, the valve is a variable opening flow device. The design of a globe valve 

also creates a slight retardation to the flow because the fluid is forced to make 

adouble turn and passes through the opening at 90° to the axis of the pipe. The 

valve plug is raised or lowered to stop or regulate the flow through a circular 
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opening. A globe valve can be identified by the spherical body and the arrow mark 

for the direction of flow. These valves are used in water pipe lines from 12 mm to 

100 mm or even larger diameter for the flow control purpose. 

Gate valve:A gate valve is on-off type valve. It allows a straight-line movement of 

fluid and offer very little resistance to the flow in fully opened position. The central 

disc moves completely out of the passage and leaves a full opening. Figure shows a 

simple type of gate valve partially opened in position. These valves are very widely 

used in water pipe lines of diameter ranging from 12 mm to higher values. A gate 

valve can be identified by its slim body. It is to be noted that there will be no arrow 

mark or the body of valve because it can be used in both ways 

Foot valve: Foot valve is a kind of non-return 

valve used in centrifugal pumps. It is fitted at the 

bottom most end of the suction pipe (Foot) to stop 

flow in the downward direction for priming 

purpose. The strainer restricts the entry of floating 

materials to the pipe line. Figure gives the details 

of the foot valve. The material used may be cast 

iron, brass, or PVC. 
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ENGINEERING WORKSHOP VIVA QUESTIONS 

Q.1 what is the importance of workshop?  

ANS: - Workshop is the center of learning about engineering Materials, manufacturing 

practices, equipments, tools and safety precaution to be observed in manufacturing 

operations. 

Q.2 Name the machines you know?  

1. Hacksaw machine  

2. Lathe machine 

3. Shaping machine 

4. Drilling machine 

5. Slotting 

6. Bench grinder 

7. Press machine 

8. Milling machine 

Q.3 Name of any five measuring instruments?  

1. Try square  

2. Vernier caliper  

3. Micrometer  

4. Divider  

5. Inside caliper 

Q.4 what is the use of divider?  

ANS: - It is used for marking arc, dividing a line or transferring the dimension. 

Q.5 what is sheet metal work?  

ANS Sheet metal work is used for making, Cutting and bending  

Q.6 which are the sheets of metals?  

1. Galvanized iron  

2. Stainless steel  

3. Copper  

4. Aluminum  

 

Q.7 Name the sheet metal hand tools?  
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Steel rule ,Vernier caliper, Micrometer, Scriber Divider, hammer, mallet ,Shear. 

Q.8 what is G.I.?  

ANS G.I. is galvanized iron  

Q.9 what is shearing?  

ANS :Shearing means for sheet metal cutting. 

FITTING 

Q.1 what is the name of vice used in fitting shop?  

ANS: Bench vice  

Q.2 Name the different files?  

1. Hand file  

2. Flat file  

3. Square file  

4. Triangle file  

5. Half round file  

6. Round file  

7. Swiss or needle file  

8. Rough file & Smooth file  

Q.3 which tools are used in fitting shop?  

1. Steel rule  

2. Try square  

3. Vernier caliper  

4. Scriber  

5. Center punch  

6. Hammer  

7. Hacksaw frame with blade  

8. Rough file & Smooth file  

Q.4 what is the use of center punch?  

ANS: Center punch used in a bench work for marking out work, locating center etc.  

 

Q.5 what is the use of try square?  

ANS: To measuring straightness and surface of the given work piece (90 Degree) 
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CARPENTRY 

Carpentry may be defined as the process of making wooden components. It starts from a 

Marketable form of wood and ends with finished products. It deals with the building work, 

furniture, Cabinet making. 

Q.1: Name the common carpentry tools?  

1. Steel rule  

2. Try square  

3. hand  saw  

4. firmer chisel  

5. Jack plane  

6. Rasp cut file  

7. Hammer  

8. Wooden mallet  

Q.2 what is the use for firmer chisel?  

ANS: To make groove  

Q.3 what is the use of metal jack plane?  

ANS: To make smooth surface  

Q.4 what is the use of Rasp file?  

ANS: Rasp file is used for cleaning up some curved surface  

Q.5 Name the carpentry process?  

1. Marking  

2. Sawing  

3. Planning  

4. Chiseling  

5. Grooving 

Q.6 Types of planes 

1. Jack plane 

2. Smoothing plane 

3. Rebate plane 

4. Plough plane 

Q.7 Types of saws 
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1. Cross‐cut or hand saw 

2. Rip saw 

3. Tenon saw 

4. Compass saw 

Q.8 Types of chisels 

1. Firmer 

2. Dovetail 

3. Mortise 

TIN SMITHY 

many engineering and house hold articles such as hoppers, guards, covers, boxes, cans, 

funnels, ducts, etc… are made from a flat sheet (G I) of metal the process being known as 

tin smithy  

Tools required 

1. Steel rule,  

2. Try-square,  

3. Divider,  

4. Scriber, 

5. Straight snip, 

6. Mallet, Cross-peen hammer and stake. 

Sequence of operations  

 Cutting , Bending ,Inspection. 

 

Types of stakers  

1. Horse head stake 

2. Pipe stake 

3. Convex stake 

4. Funnel stake  

5. Hatchet stake  

6. Half moon stake 
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What is the raw material used in Tin smithy for doing experiments 

Ans: galvanized iron 

A sheet of soft steel, which is coated with molten zinc, is known as galvanized iron.  

WELDING 

Welding is the process of joining similar metals by the application of heat, with or without 

Application of pressure or filler metal, in such a way that the joint is equivalent in 

composition and Characteristics of the metals joined. 

Q.1 Name the types of welding?  

1. Electric  Arc welding  

2. Argon welding  

3. Gas welding  

4. Tig welding  

5. Mig welding  

6. Spot welding  

7. Plasma arc welding  

8. Friction welding  

Q.2 which is the welding process you have carried out in workshop?  

ANS: Electric arc welding  

Q.3 what is welding?  

ANS: Welding is the process of joining similar metals by the application of heat, 

Q.4 Name the device used in welding process?  

ANS: transformer 

Q.5 which outer cover is on the welding rod?  

ANS: Silicon 

Q.6 Name the welding tools used in workshop? 

1. Welding holder, 

2.  welding rod, 

3.  Ground clamp  

4.  hand gloves,  

5. chipping hammer,  

6. wire brush 
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7. Face shield  

BLACK SMITHY 

 
Q.1 Name the types of furnace?  

ANS: Open hearth furnace  

Q.2 Name the tools used in smithy shop?  

1. Anvil  

2. Swage block  

3. Sledge hammer  

4. Flat bit tongs , square bit tongs, round bit tongs, pickup tongs   

Q.3 why furnace is used in our workshop?  

ANS: To heat the job to set the required shape  

Q.4 forging temperature of mild steel rod?  

ANS: 750
0
c-1300

0
c  

Q.5 what is use of anvil & swage block?  

ANS: Anvil for the support the job. Swage block is used for squaring, sizing, bending & 

forming operation 

Q.6 Advantages of forging? 

1. Strength and toughness is high. 

2. Strength to weight ratio is high. 

3. Internal defects are eliminated. 

4. Forged parts need less or no machining. 
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FOUNDRY 

1. List the tools and equipment used in foundry. 

They are, Hand tools, Containers, Mechanical tools, Sand testing & conditioning equipment, 

Metal meltingequipment, Fettling & finishing equipment 

2. List the Hand tools used in Foundry. 

Shoel, Hand riddle, Rammers, Strike off bar, Towels, Slicks, Lifters or cleaners, Drag Spike, 

Draw screws andrapping plate, Smoothers and corner slicks, Mallet, Swab, Sprue pin, Sprue 

cutter, Goggers, Bellow. 

3. What is the function of Hand riddle? 

Used for hand riddling of sand to remove foreign material from it.  

4. What is a Rammer?  

Rammers are used for striking the sand mass in the moulding box to pack it uniformly around 

the pattern 

 

Give the classification of Rammer. 

1. Peen rammer  

2. Hand rammer  

3 .  F l o o r  r a m m e r   

 

5. What is the use of Vent wire in foundry? 

It is a thin steel rod. After ramming and striking off the excess sand it is used to make small 

holes, called vents, in the sand mould to allow the exit of gases and steam during casting. 

6. What is a Mallet? 

In foundry work it is used for driving the draw spike into the pattern and the rapping it. 

7. What is a Swab?  

It is a hemp fiber brush used for moistening the edges off sand mould, which are in contact 

with the pattern surface, before withdrawing the pattern. 

8. What is the use of sprue cutter? 

It is used to produce the hole after ramming the mould. It is in the form of a tapered hollow 

tube. 

9. What are Goggers?  

Bent of pieces wires and rods which are used for reinforcing the downward projecting sand 

mass I the cope.  
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10. What is the use of Bellow? 

Used to blow but the loose or unwanted sand from the surface and cavity of the mould. 

11. Mention the use of Trowels? 

Used for finishing flat surfaces and joints in a mould. 

12. What are Slicks?  

They are used for repairing & finishing the mould surfaces & edges after  

13. Which is the commonly used Slick? 

The commonly used slicks are Heart & Leaf, Square & Heart, Spoon & Bead, Heart & 

Spoon. 

14. List the containers used in foundry. 

1. Moulding boxes or flasks 

2. Ladles 

3 .  C r u c i b l e s .  

15. Mention the material of moulding boxes. 

Made of Wood, Cast iron or steel. 

16. Why Dry sand moulds always require metallic boxes? 

Because dry sand moulds are heated for drying. 

17. Why the Ladles are used? 

They are used to receive molten metal form the melting furnace and pour the same into the 

mould. 

18. What is the capacity of ladles? 

It’s capacity ranges from 30 kg – 1000 kg. 

19. Why we required Crucibles? 

They are similar in shape to the ladles. They are used as metal melting pots. 

20.Define molding machine?Is device which, by means of large number of correlated 

internal parts and mechanisms, transmits & directs various forces & motions in required 

directions so as to help the preparation of a sand mould. 

20. What are the Functions of molding machines? 

1.Ramming of moulding sand 

2.Rolling over or inverting the mould 

3.Rapping the pattern. 

4 .  Wi th d r aw in g  t h e  p a t t e r n  f ro m t h e  mo u l d .  

21. Mention the types of moulding machines. 
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1. Jar / Jolt machine 

2. Squeezer machine 

3. Jolt – Squeezer machine 

4. Slinging machines or sand slingers. 

5 .  D i a p h r a g m  m o u l d i n g  m a c h i n e  

22. W h e r e  w e  g e t  t h e  f o u n d r y  s a n d ?  

The common sources of collecting foundry and are rivers, lakes, sea and deserts. 

23. Give the main group of foundry sand. 

1. Natural sand 

2 .  S i l i c a  s a n d  

24. W h a t  a r e  t h e  c o n s t i t u e n t  o f  N a t u r a l  s a n d ?  

It contains sufficient amount of binding clay.  

25. What is silica sand? 

Which do not possess the clay content and need addition of a suitable binder 

to make them usable for foundry work? 

STUDY OF LATH MACHINE 

 
Q.1 what is the function of lathe machine?  

ANS: To remove metal from a piece of work to give required shape & size  

Q.2 Name the only five parts of lathe machine?  

1. Bed  

2. Tail stock  

3. Carriage  

4. Chuck  

5. Tool post  

Q.3 What is the use of chuck?  

ANS: To hold the job  

Q.4 Name the types of chuck?  

1. Thru chuck  

2. Dock chuck  

Q.5 Name the operation which can be performed by lathe machine?  

1. Facing  

2. Turning  
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3. Chamfering  

4. Grooving  

5. Boring  

6. Parting  

7. Threading 

PLUMBING 

 
Q.1 How the pipes are specified?  

1. Material  

2. Inside diameter  

3. Wall thickness  

4. Length  

Q.2 which is the common pipes used nowadays?  

ANS:  pvc  

Q.3 which vice used in plumbing  

ANS: Pipe vice  

Q.4 Name only five fittings?  

Ans:Elbow ,Tee ,Union ,Coupling ,Reducer  

Q.5 what is B.S.P.?  

ANS: British Standard Pipe 
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PROGRAM OUTCOMES (POs) 

A B.Tech – graduate should possess the following Program outcomes. 

 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering fundamentals, 

and an engineering specialization to the solution of complex engineering problems. 

 

2. Problem analysis: Identify, formulate, review research literature, and analyze complex engineering 

problems reaching substantiated conclusions using first principles of mathematics, natural sciences, 

and engineering sciences. 

 

3. Design/development of solutions: Design solutions for complex engineering problems and design 

system components or processes that meet the specified needs with appropriate consideration for the 

public health and safety, and the cultural, societal, and environmental considerations. 

 

4. Conduct investigations of complex problems: Use research-based knowledge and research methods 

including design of experiments, analysis and interpretation of data, and synthesis of the information 

to provide valid conclusions. 

 

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modelling to complex engineering activities with an 

understanding of the limitations. 

 

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess 

societal, health, safety, legal and cultural issues and the consequent responsibilities relevant to the 

professional engineering practice. 

 

7. Environment and sustainability: Understand the impact of the professional engineering solutions in 

societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development. 

 

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of 

the engineering practice. 

 

9. Individual and team work: Function effectively as an individual, and as a member or leader in 

diverse teams, and in multidisciplinary settings. 

 

10. Communication: Communicate effectively on complex engineering activities with the engineering 

community and with society at large, such as, being able to comprehend and write effective reports 

and design documentation, make effective presentations, and give and receive clear instructions. 

 

11. Project management and finance: Demonstrate knowledge and understanding of the engineering 

and management principles and apply these to one’s own work, as a member and leader in a team, to 

manage projects and in multidisciplinary environments. 

 

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change. 

 

 

 

 



 (R18A0084) IT WORKSHOP LAB 

Syllabus 

OBJECTIVES: 

 The IT Workshop for engineers is a training lab course spread over 54 hours. The 

modules include training on PC Hardware, Internet & World Wide Web and 

Productivity tools including Word, Excel, and Power Point 

 PC Hardware introduces the students to a personal computer and its basic peripherals, 

the process of assembling a personal computer, installation of system software like MS 

Windows; In addition hardware and software level troubleshooting process, tips and 

tricks would be covered. 

 Internet & World Wide Web module introduces the different ways of hooking the PC on 

to the internet from home and workplace and effectively usage of the internet. Usage of 

web browsers, email, newsgroups and discussion forums would be covered. In addition, 

awareness of cyber hygiene, i.e., protecting the personal computer from getting infected 

with the viruses, worms and other cyber attacks would be introduced. 

 Productivity tools module would enable the students in crafting professional word 

documents, excel spread sheets, power point presentations and personal web sites using 

the Microsoft suite of office tools. 

 HTML introduction for creating static web pages 

PC HARDWARE 

Week 1: 

Identify the peripherals of a computer, components in a CPU and its functions. Draw the 

block  diagram of the CPU along with the configuration of each peripheral. 

Week 2: 

Assembling and disassembling of PC. 

Week 3: 

Every student should individually install MS windows on the personal computer. 

Basic DOS Commands. 

Week 4: Hardware Troubleshooting 

Students have to be given a PC which does not boot due to improper assembly or 

defective peripherals 

Software Troubleshooting: Students have to be given a malfunctioning CPU due to 

system software problems. They should identify the problem and fix it to get the 

computer back to working condition. 

 

Week 5: INTERNET & WEB BROWSERS 



Web Browsers, Surfing the Web: Students customize their web browsers with the LAN 

proxy settings, bookmarks, search toolbars and pop up blockers And How to access the 

websites and email& Search Engines & various threats on the internet and would be 

asked to configure their computer to be safe on the internet, Antivirus downloads to 

avoid viruses and/or worms. 

MS OFFICE 

Week 6: MICROSOFT WORD 

Word Orientation: an overview of Microsoft (MS) office 2007/ 10: Importance of MS 

office 2007/10, overview of toolbars, saving files, Using help and resources, rulers, 

format painter. Table of Content, Newspaper columns, Images from files and clipart, 

Drawing toolbar and Word Art, Formatting Images, Textboxes, Paragraphs and Mail 

Merge in word. 

Using Word to create project certificate. Features to be covered:-Formatting Fonts in 

word, Drop Cap in word, Applying Text effects, Using Character Spacing, Borders and 

Colors, Inserting Header and Footer, Using Date and Time option in Word &Formatting 

Styles, Inserting table, Bullets and Numbering, Changing Text Direction, Cell 

alignment, Footnote, Hyperlink, Symbols, Spell Check, Track Changes. 

Week 7: MICROSOFT EXCEL 

Excel Orientation:  The importance of MS office 2007/10 tool Excel as a Spreadsheet 

tool, Accessing, overview of toolbars, saving excel files, Using help and resources. 

Creating a Scheduler - Features to be covered:- Gridlines, Format Cells, Summation, 

auto fill, Formatting Text 

Calculating GPA - .Features to be covered:- Cell Referencing, Formulae in excel – 
average, std. deviation, Charts, Renaming and Inserting worksheets, Hyper linking, 

Count function, LOOKUP/VLOOKUP, Sorting, Conditional formatting . 

Week 8: MICROSOFT POWER POINT 

Basic power point utilities and tools which helpful to create basic power point 

presentation. Topic covered during this includes PPT Orientation, Slide Layouts, 

Inserting Text, Word Art, Formatting Text, Bullets and Numbering, Auto Shapes, Lines 

and Arrows in both Latex and Power point. 

a) Create the presentation using the following tools: 

Formatting: Color, font type, font size, font style etc. 

Header and Footer 

Bullets and Numbering 

Drawing Toolbar: Auto shapes, Textboxes, etc 



Design Template 

Introduction to custom animation. 

 

b)  Create a presentation to conduct a creativity session using the following tools: 

1. Slide transition      

2. Master slide view 

3. Insert picture – clipart, image 

4. Action button 

5. Drawing tool bar – lines, arrows 

6. Hyperlink 

7. Custom animation 

8. Hide slide 

9. Wash out 

Week 9: HTML 

Introduction to HTML & Basic HTML Tags: Understand what are the tasks used for 

creation of website 

Designing a static web page: Understand how to create a webpage. 

 

Text Books: 

1.Introduction to Information Technology,ITL Education Solutions 

limited,Pearson Education 

2.PC Hardware and A+ Handbook-Kate J.Chase PHI(Microsoft) 

OUTCOMES: 

 The Students are able to identify the major components of a computer and its 

basic peripherals. They are capable of assembling a personal computer, and can 

perform installation of system software like MS Windows and required device 

drivers. 

 Students can detect and perform minor hardware and software level 

troubleshooting. 

 The Students are capable of working on Internet & World Wide Web and can 

make effective usage of the internet for academics. 

 The Students develop ability to prepare professional word documents, excel 

spread sheets and power point presentations using the Microsoft suite of office 

tools. 

 The students are able to create a static webpage’s using HTML. 
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TASK 1 

Identify the peripherals of a computer, components in a CPU and its functions.  

 

A peripheral device is an internal or external device that connects directly to a computer but does not 

contribute to the computer's primary function, such as computing. It helps end users access and uses the 

functionalities of a computer. 

Types of Peripheral Devices 

There are many different peripheral devices, but they fall into three general categories: 

1. Input devices, such as a mouse and a keyboard 

2. Output devices, such as a monitor and a printer 

Storage devices, such as a hard drive or flash drive 

3. The central processing unit (CPU) of a computer is a piece of hardware that carries out the 

instructions of a computer program. It performs the basic arithmetical, logical, and input/output operations 

of a computer system. The CPU is like the brains of the computer - every instruction, no matter how simple, 

has to go through the CPU. 

A typical CPU has a number of components. The first is the arithmetic logic unit (ALU), which performs 

simple arithmetic and logical operations. Second is the control unit (CU), which manages the various 

components of the computer. It reads and interprets instructions from memory and transforms them into a 

series of signals to activate other parts of the computer. The control unit calls upon the arithmetic logic unit 

to perform the necessary calculations. Third is the cache, which serves as high-speed memory where 

instructions can be copied to and retrieved. 

 

A computer can process data, pictures, sound and graphics. They can solve highly complicated problems 

quickly and accurately. 

Input Devices 

The device which are connected to computer and they are used to send the data to the computer 

internally, are known as the input devices. Following are some important input devices; 
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Mouse: Mouse is the one of the most common device that one would find in a desktop. It is normally 

plugged with the USB connection. It would be connected through the PS/2 port which is located on the 

back of the computer. In older system, one might find the serial port which was used to move the move 

around. The old mouse contained ball inside of it which helped it move. But nor the trend has changed the 

mouse that one uses contains some LED light. They are called the laser mouse. The LED light now emits 

out of the mouse sensing that where the mouse is being moved. The installation of mouse is easy, one can 

just plug the mouse and the drivers would be searched by windows itself. The mouse can be configured 

from the control panel where the speed of it can be improved. 
 

Keyboard: it is the famous device that is being used today and it is connected through a USB connection at 

the back of the computer. Old keyboards used to have the Mini DIN PS/2 connection with them; one would 

have to go through the manufacturer's website to know that what are the drivers for the keyboard and then 

can get them installed when he connects the keyboard with the computer. 
 

Touch screen: Touch screen is becoming common as well. They are normally used on the mobile phones 

and other smart devices. Also, the tablets also contain this feature. Now it is even common to find a 

computer's large screen which works with the touch screen system. It makes it very easy to type and 

navigate and one can bring the keyboard on the screen and type it there as well hence one doesn't have to 

install the keyboard. The configurations and the installation of the touch screen are also done in a display 

when it is bought. 
 

Scanner: At a time, the fax machines were widely used by the people and till now, they use it. But now the 

tables have turned and people tend to use the scanners. The scanners have the ability to turn the paper's 

image into a digital one hence sending the data from one place to another while keeping the same paper 

with us is now an easy task and the data can be sent more easily through the internet. The scanners are now 

used a lot and one can simply scan a paper and save it in any format he wants to. 

 

Barcode reader: If one goes to some super market or the retail environment, one would see the barcode. 

It's a machine that is used to read the code which is printed at the back of the products. The connection of 

the bar code is normally made through the USB connection. Some old versions of the bar codes also use 

the PS.2 connections to get connected to the computer. The barcodes use the laser technology to read the 

barcode. The light comes and goes when the code is exposed to the barcode reader. This eye can directly 

damage one's eye as well so one has to be careful while using this machine. The barcode contains a specific 

driver when it is connected, the driver is detected by the windows and hence it can work properly. 
 

KVM: If one is working in an environment where there is a single display but there are many different 

computers connected to it, the one is using the KVM. KVM means the keyboard, video and the mouse. 

Here if one wants to move to another device, he just has to push a single button to get to other device. This 

set can be centralized and the KVM can be used to switch between all the computing devices. 

 

Microphone: the putting of voice in our computer is very common. It is done by the chat or it is even done 

for the voice reorganization software's which are available in the market. Microphones on not only at the 
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headset, but they can be found separately and are there in the laptops as well. They also have the specific 

drivers and the configuration can be made through the control panel. 

 

Biometric devices: these devices are used as the security tools. They are mostly used on some portable 

devices which tend to go away from one. If one tries to use the laptop, he might find there is a finger print 

reader there and hence it is protected since only the administrator who has set it up can log in to the 

computer. 
 

Game pads: Game pad is the wonderful thing for the gamers. It allows the gamers to have some control 

over the gaming experience. 
 

Joysticks: it is the gaming input which is widely used. It is a stick which has many buttons on it. 
 

Digitizer: the digitalizing pad has some specialized pins that allow the user to draw on it very carefully and 

accurately. They are for those who have got some artistic abilities and they are installed with the driver. 

 

Touch Screen    Biometric Device                              KVM      

                     

Multimedia devices 

Digital cameras: the digital cameras are the standalone cameras which are used by the individuals. These 

days almost everyone has got a digital camera and they are even embedded into the mobile phone where 

they can be used to take picture. The digital cameras when connected to the PC for transfer of pictures 

require the driver to get installed and that driver comes with the accessories. 
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Microphone: if one wants to do some conferences or the voice chat, he would be meeting the 

microphone. They are available as the separated ones as well which can be easily used. They are normally 

connected through some USB connection and there is the digital connector which is associated with it to 

provide the high quality. 
 

 

Webcam: Having a video is now a great need of the everyday life. Now it is very common to find some 

built in cameras into the displays which are being used these days. Specially, they are so common in the 

laptop and if they are not present, it is pretty common to get it connected and it is done pretty cheap 

amount. One can also enjoy the live video if it is plugged through the 802.11 wireless connections which 

go into the USB connection in the computer. 
 

 

Camcorder: Most of the video conference has to be recoded and hence one needs the camcorders. They 

are normally done for some live videos. Normally those people, who upload videos on the video sharing 

websites like YouTube etc., use this tool to record the videos and then can upload them on the PC, were 

after editing, they can upload it on the website. They are not only into the digital cameras but they can be 

found easily on every laptop and almost every mobile phone so one can record anything anytime without 

any hustle. The video is stored in the flash memory. There is mostly having the large storage capacities in 

the digital cameras so that the videos can be recorded no matter how big they are. For transferring the 

videos off the camera, one would need a Firewire, it is a kind of direct HDMI connection and it can be 

used to display the video immediately on some display. 

 
MIDI enabled devices: MIDI stands for the Musical Instrument Digital Interface. It is actually a device 

which is musical one and can digitalize all of the information and can transfer it to the computer in some 

really standard way. Many of the application which contains these capabilities of the music use this midi as 

the standard format so that the information can be getting in and out of the computer. It is common to get 

these devices plugged into the computers with the help of some Ethernet cables and even the USB cables. 

While on the different side there in instrument is coated, the large din connections are used to get connected 

between the commuter and the device. 

         

              Webcam                                  Camcorder                   MIDI enabled device 
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                   Microphone                             Digital cameras 

Output Devices: 

Output devices are those devices which do not send the data into the computer, in fact through these 

devices, the computer communicates with the user. Some of these output devices are as follows; 

 

Printers: if one has the data in the computer, it is obvious that he has to take it out of the computer. There 

are several ways for it and one of them is the painters. These printers are available not only in the office 

environment and in some retail environment, but at the homes as well. One might need the printer to take 

out the prints of the important information he finds on the internet or the assignment which he creates. At 

office, many important documents are sent and received in the digitalized format and they have to be 

converted to the hard copy so they can be read easily. At the shops, one might find the painters which are 

used for printing out the receipts which are handed over to the customers. Hence printers are used in every 

aspect of the busy life. Printers have various types and the laser printers are the most famous type since 

they print really good. For printers there is much software and one must install the appropriate drivers to 

get them work. The configuration of the printer can be done manually once it is connected to the computer. 

 
   Speakers: many of the features which are used by us are mainly related to the audio. Doesn't matter     
whether one listens to the podcasts or plays music, He would need the audio to be heard. Even while 
watching the movie or some educational video, hearing the voice is really important part and for that 
purpose, one needs the speakers. The laptop contains the right left speakers which are located at these both 
sides. There is also a subwoofer which can be used for the mixing of the voice. Also, one can have some 
advanced computer speaker which can be plugged into the computer externally for the sake of better 
quality of the sound. The laptops have various options which are provided to user so that he can hear the 
sound with different options. 

Display devices: one of the most integral parts of the PC is the display devices which are used. The human 

beings need to see that what's going on the operating system and to get in touch with the interface, they 

must have some display device which can show them the appropriate amount of data. Normally the display 

devices are pretty thin and one has many options for the display devices and they vary in prices range as 

well. These device can be both non touchable and the Touch Screen. These display devices are not just 

connected to the computers; instead they are connected to the mobile phones as well. Also the Tablets 

contain some display devices as well.  
These displays show us what is exactly going on there and how we can control the computer 
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 The Mother Board 

 
The important constituent components of an ATX Motherboard are given below: 

 

 

There are primarily two types of motherboards, AT motherboard, and ATX motherboard. The AT and 

ATX motherboards differ in the form factor. Full AT is 12" wide x 13.8" deep, and Baby AT is 8.57" 

wide x 13.04" deep. Full-ATX is 12" wide x 9.6" deep and Mini-ATX is 11.2" wide x 8.2" deep. Other 

major differences include power supply connector, and keyboard connector. AT has 5-pin large keyboard 

connector, whereas ATX has 6-pin mini connector. Similarly, AT has single row two connectors +/-5V, 

and +/-12V, whereas ATX motherboard has double row single connector providing +/-5V, +/-12V, and 

+3.3V. 

    USB (Universal serial bus): USB is the General-purpose connection for PC. You can find USB 

versions of many different devices, such as mice, keyboards, scanners, cameras, and even printers. a 

USB connector's distinctive rectangular shape makes it easily recognizable. USB has a number of 

features that makes it particularly popular on PCs. First, USB devices are hot swappable. You can insert 

or remove them without restarting your system. 

 

    Parallel port: Most printers use a special connector called a parallel port. Parallel port carry data on 

more than one wire, as opposed to the serial port, which uses only one wire. Parallel ports use a 25-pin 

female DB connector. Parallel ports are directly supported by the motherboard through a direct 

connection or through a dangle. 

  

  CPU Chip: The central processing unit, also called the microprocessor performs all the calculations 

that take place inside a pc. CPUs come in Variety of shapes and sizes.Modern CPUs generate a lot of heat 

and thus require a cooling fan or heat sink. The cooling device (such as a cooling fan) is removable, 

although some CPU manufactures sell the CPU with a fan permanently attached. 
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RAM slots: Random-Access Memory (RAM) stores programs and data currently being used by the 

CPU. RAM is measured in units called bytes. RAM has been packaged in many different ways. The most 

current package is called a 168-pin DIMM (Dual Inline Memory module). 

 

 Floppy controller: The floppy drive connects to the computer via a 34-pin ribbon cable, which in 

turn connects to the motherboard. A floppy controller is one that is used to control the floppy drive. 

 

IDE controller: Industry standards define two common types of hard drives: EIDE and SCSI. Majority 

of the PCs use EIDE drives. SCSI drives show up in high end PCs such as network servers or graphical 

Workstations. The EIDE drive connects to the hard drive via a 2-inch-wide, 40-pin ribbon cable, which in 

turn connects to the motherboard. IDE controller is responsible for controlling the hard drive. 

 
PCI slot: Intel introduced the Peripheral component interconnect bus protocol. The PCI bus is used to 

connect I/O devices (such as NIC or RAID controllers) to the main logic of the computer. PCI bus has 

replaced the ISA bus. 

 

ISA slot (Industry Standard Architecture): It is the standard architecture of the Expansion bus. 

Motherboard may contain some slots to connect ISA compatible cards. 

 

 CMOS Battery: To provide CMOS with the power when the computer is turned off all motherboards 

comes with a battery. These batteries mount on the motherboard in one of three ways: the obsolete external 

battery, the most common onboard battery, and built-in battery. 

 

 AGP slot:If you have a modern motherboard, you will almost certainly notice a single connector that 

looks like a PCI slot, but is slightly shorter and usually brown. You also probably have a video card 

inserted into this slot. This is an Accelerated Graphics Port (AGP) slot. 

 

CPU Slot: To install the CPU, just slide it straight down into the slot. Special notches in the slot make 

it impossible to install them incorrectly. So remember if it does not go easily, it is probably not correct. 

Be sure to plug in the CPU fan's power. 

 

Power supply plug in: The Power supply, as its name implies, provides the necessary electrical 

power to make the pc operate. The power supply takes standard 110-V AC power and converts into +/-12-

Volt, +/-5-Volt, and 3.3-Volt DC power. 
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CPU (Processor): The central processing unit (CPU, occasionally central processor unit) is the 

hardware within a computer system which carries out the instructions of a computer program by 

performing the basic arithmetical, logical, and input/output operations of the system. 

 

 

 

SMPS (Switched mode Power Supply): A switched-mode power supply (switching-mode 

power supply, SMPS, or switcher) is an electronic power supply that incorporates a switching regulator 

to convert electrical power efficiently. 

Cabinet: A computer cabinet is an enclosure with fitted, fixed or removable side panels and doors. The 

cabinet contains a computer rack for mounting computers or other electronic equipment. 

 

 CPU heat Sink and fan: A computer fan is any fan inside, or attached to, a computer case used 

for active cooling, and may refer to fans that draw cooler air into the case from the outside, expel warm 

air from inside, or move air across a heat sink to cool a particular component. 
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RAM (Random Access Memory): RAM (random access memory) is the place in a computer where the 

operating system, application programs, and data in current use are kept so that they can be quickly reached 

by the computer's processor. RAM is much faster to read from and write to than the other kinds of storage in 

a computer, the hard disk, floppy disk, and CD-ROM. However, the data in RAM stays there only as long as 

your computer is running. When you turn the computer off, RAM loses its data. When you turn your 

computer on again, your operating system and other files are once again loaded into RAM, usually from 

your hard disk. 

 

 

HDD (Hard Disk Drive): The hard disk is housed inside the hard drive, which reads and writes data 

to the disk. The hard drive also transmits data back and forth between the CPU and the disk.  

 

 

 

 
 

SATA: The term SATA generally refers to the types of cables and connections. Serial ATA 
replaces Parallel ATA as the IDE standard of choice for connecting storage devices inside of a 
computer.SATA storage devices can transmit data to and from the rest of the computer much, much faster 
than an otherwise similar PATA device. 
 

 

 

 

 

 

 

 

 

 

 

 

 

CD-ROM Drive: Short for Compact Disc-Read Only Memory, a CD-ROM (shown right) is 
an optical disc which contains audio or software data whose memory is read only. A CD-ROM 

https://www.lifewire.com/parallel-ata-pata-2625957
https://www.computerhope.com/jargon/c/compactd.htm
https://www.computerhope.com/jargon/r/readonly.htm
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Drive or optical drive is the device used to read them. CD-ROM drives have speeds ranging from 1x all 
the way up to 72X, meaning it reads the CD roughly 72 times faster than the 1x version. 
 

CD Writer: A CD writer is a piece of computer equipment that you use for copying data from a 
computer onto a CD. 

 
 

Different Screws Used: Screws are the hardware used to secure parts of a PC to the case. Although 

there are numerous manufacturers of computer cases, they have generally used three thread sizes. 

 

 

 

 

AGP (Accelerated Graphics Port) Card: Stands for "Accelerated Graphics Port." AGP is a type 
of expansion slot designed specifically for graphics cards 

 

LAN (Local Area Network) Card: A network interface card (NIC) is a computer circuit board or card that is 

installed in a computer so that it can be connected to a network. Personal computers and workstations on a 

local area network (LAN) typically contain a network interface card specifically designed for the LAN. 

https://www.collinsdictionary.com/dictionary/english/writer
https://www.collinsdictionary.com/dictionary/english/equipment
https://www.collinsdictionary.com/dictionary/english/copying
https://www.collinsdictionary.com/dictionary/english/datum
https://en.wikipedia.org/wiki/Screw
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Computer_case
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Exercise: 

1. Draw the block diagram of the CPU along with the configuration of each peripheral. 
  

2.Write software and hardware requirements of a PC 
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TASK 2 

 

Assembling and Dis-Assembling of PC 

 

Preparations 

Computer motherboards and expansion cards contain very delicate integrated circuit(IC) chips. To protect 

them against damage from static electricity, you should follow some precautions whenever you work on 

your computer. 

1. Unplug your computer when working on the inside. 

2. Use a grounded wrist strap before handling computer components. If you do not have one, touch both of 

your hands to a safely grounded object or to a metal object, such as the power supply case. 

3. Hold components by the edges and try to not touch the IC chips, leads or connectors, or other 

components. 

4. Place components on a grounded anti-static pad or on the bag that came with the components whenever 

the components are separated from the system. 

5. Ensure that the ATX power supply is switched off before you plug in or remove the ATX power cod. 

Assembling a Computer 

After buying all the computer components they must be put together. This process is called assembling. It 

usually takes about fifteen minutes (installing not included). Although easy, it must be done carefully so as 

to avoid unnecessary damage to the system. 

Materials Required 

Make sure that you have all the below materials before starting. 

1. All the necessary components  
·  Processors 
·  Motherboard 
·  Hard disk 
·  RAM 
· Cabinet 
·  Floppy Drive 
·  CD Drive 
·  Cards 
_ Display Card (Not needed if On-board display is available on Motherboard) 
_ Sound Card (Not needed if On-board sound is available on Motherboard) 
_ Modem 
_ Other Cards (If Any) 
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·  Monitors 
·  Keyboard 
·  Mouse 
·  Speaker 
·  UPS 
· Other Components (If Any) 
·  Also keep the cables that came with the components close by 
2. Head Screwdriver (also known as Star Screwdriver) 
3. Flat head Screwdriver 
4. Forceps (for pulling out jumpers and screws) 

5. Magnetized Screwdriver 

6. Multi meter (Testing) 

 

Computer Assembling steps 

1. Open the  case 

2. Connect the power supply 
3. Attach  components to the motherboard 
4. Fix the  motherboard 
5. Install internal drives 
6. Install drives in external slots 
7. Install adapter  cards 
8. Connect all internal cables 
9. Re-attach the side  panels 

10. Connect external cables to  the computer 
11. Boot the computer for the first time 
 

Computer        Disassembly steps 

1. Power off the system 
2. Unplug power cables 
3. Disconnect external cables from the computer 
4. Detach the side panels /open the case 
5. Disconnect all internal cables 
6. Remove adapter cards 
7. Remove drives from external slots 
8. Uninstall internal drives 
9. Unfix the motherboard 

10. Detach the components from the motherboard 
11.  the power supply 

 
Exercise: 

Write necessary components specifications in detail. 
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TASK 3 

 

Installation process for Windows Operating system 

 
Introduction to Installation of Windows 10 

  
Windows 10 is a personal computer operating system developed and released by Microsoft as part of 

the Windows NT family of operating systems. It was released on July 29, 2015 

Windows 10 introduces what Microsoft described as "universal apps"; expanding on Metro-style apps, these 

apps can be designed to run across multiple Microsoft product families with nearly identical code 

including PCs, tablets, Smart phones, embedded systems, Xbox One, Surface Hub and Mixed Reality 

Step 1:  This is the first screen you will see if you install Windows 10 using a bootable USB flash drive or DVD. 

Here’s where you choose the OS’ language, time and currency format, and input method. 

 

 

  

https://en.wikipedia.org/wiki/Microsoft
https://en.wikipedia.org/wiki/Windows_NT
https://en.wikipedia.org/wiki/Universal_app
https://en.wikipedia.org/wiki/Metro-style_app
https://en.wikipedia.org/wiki/Personal_computer
https://en.wikipedia.org/wiki/Tablet_computer
https://en.wikipedia.org/wiki/Smartphone
https://en.wikipedia.org/wiki/Embedded_system
https://en.wikipedia.org/wiki/Xbox_One
https://en.wikipedia.org/wiki/Surface_Hub
https://en.wikipedia.org/wiki/Windows_Mixed_Reality
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Step 2: It's pretty obvious what you need to click here. Like Windows 8.x, you can also choose to repair 

your computer. 
 

 

 

If you choose the repair option, you will end up at a Troubleshoot screen where you can choose to reset your 

PC and re-install windows (you can either keep or remove your files), or access more advanced troubleshooting 

options. For the latter, there are options for doing a system restore (if you’ve a restore point on your PC), image 

recovery, running commands in command prompt, and letting Windows fix any startup problems. You can also 

get to the advanced startup options after installation via the new Settings app in Windows 10. 

 

http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1-1.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1-1-1.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1-1-1.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1-1-2.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-02-1-1-2.jpg
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Step 3: Traditionally, your Windows product key can be found on your online order info, in the confirmation email 

for your purchase, or on the DVD packaging. That said, this is more for a clean install. If your device has been 

successfully upgraded to Windows 10, and you choose to wipe your device and do a clean install later, the device 

will reactivate without the need of a Windows 8.x product key. 

 

Step 4: Accept the license terms. After you read them, of course. 
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Step 5: Next, you’ll be presented with this screen, where you can choose to do either an upgrade (files, settings, 

and apps are moved to Windows) or a custom install (files, settings, and apps aren’t moved). The latter is the one 

to choose if you prefer a clean install, which was what we did. 

 

Step 6: Here’s where you select the drive to install Windows 10 on. You can format a drive here as well. 
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             Step 7: Now, you wait. 

 

 

 

 

Step 8: Before you can start using Windows, there are some personalization, location, browser and protection, and 

connectivity and error reporting settings that you can adjust. You can zip through all these by using the Express 

settings, which basically turn everything on, or you can hit the small print that says ‘Customize settings’ to 

customize them. We went for the latter. 
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Oh, notice that little icon at the bottom left? Click on it to access an accessibility menu where you can turn on things 

like a narrator, magnifier, or increase the screen contrast. 

 

 

 

Step 9: If you choose to customize the settings, the first page deals with your contact, calendar, input, and location 

data. Read these carefully to decide if you want to turn the settings on or off. 
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carefully and toggle the switches accordingly. 

 

 

Step 11: Next, you need to specify who's the owner of the device. You can choose to sign in with your company ID, 

which will give you access to your company's resources. 
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use Microsoft services like Office, Outlook.com, OneDrive, Skype, or Xbox, it makes sense to sign in with your 

Microsoft account as it ties them all up and makes your Windows experience more personal. 

 

 

If you use two-factor authentication, you’ll need to enter your code. If you don’t have a Microsoft 

account, you can create one right away. Alternatively, you can sign in with a local account. Unlike 

Windows 8.x, apps like Mail will not force you to switch to a Microsoft account and stop you from 

using the app if you don’t comply. 

 

http://www.hardwarezone.com.my/files/img/2015/07/W10install-13.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-12-1.jpg
http://www.hardwarezone.com.my/files/img/2015/07/W10install-12-2.jpg
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Step 13: Instead of signing in using your Microsoft account password, you’ve the option to create and use a short 

PIN instead. 

 

 

In addition to easy typing, another benefit is that once created, this PIN only works on the device it’s 

created on. 
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Step 14: Windows 10 will save new documents and pictures to OneDrive. If you’re okay with that, just hit Next to 

continue. Else, you can click the small text that says ‘Save new files only to this PC by default’. 

 

Step 15: You can also decide if you want to turn on the Cortana personal assistant feature. Some people may not 

want to use Cortana as this allows Microsoft to collect and use their location; contacts; voice input; info from email 

and messages; browser history; search history; calendar details; and more. If you were to ask us, Cortana is one of 

the best features in Windows 10. And for it to be truly useful, it has to be granted access to such data. Here’s a link 

to Microsoft’s privacy statement. 

 

At some point, you'll also be asked if you want to set the built-in apps to be the default apps for certain tasks. Simply 

untick the checkboxes for those that you don't want the installer to change. 
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Step 16: There's no step 16. Welcome to Windows 10!  



 

MRCET    Page 25 

 

Department of IT/CSE 

 
IT Workshop Lab Manual  

MS-DOS commands 

Exposure to Basic commands in MS-DOS commands like ver, vol, date, time, cls, dir, md, cd, path, rd, copy con, 

type, copy, move, del, ren, prompt, ipconfig etc. 

Directory Structure of DOS: One thing is to be kept in mind is that a directory can have as many child 
(sub) directories, but the child directory can have only one parent directory. (DIR) 

These internal commands are further grouped according to their properties. These are as follows. 

General purpose File related commands Directory related commands 

1.CLS 

2. DIR  

3. VER 

4. VOL 

5. DATE 

6. TIME 

7.PROMPT 

8.ECHO 

9. COPY CON 

10. TYPE 

11. COPY 

12. REN 

13. DEL 

14. MD 

15. CD 

16. RD 

17. PATH 

18. MOVE 

19.TREE 

20. IPCONFIG 

General purpose commands  

1. CLS:- (Clear the screen) This command is used to clear the screen or wipe out every thing written on the 
screen. 

Syntax:-    C:\> CLS   and press Enter 

2. DIR:- (Directory) Dir command is used for listing files and directories present in the current disk. 

Syntax:-  C:\> DIR [/options] 

Example:-   C:\> DIR /P 

 

 

http://www.rcppmail.org/DOS/Internal_commands.htm#CLS
http://www.rcppmail.org/DOS/Internal_commands.htm#DIR
http://www.rcppmail.org/DOS/Internal_commands.htm#VER
http://www.rcppmail.org/DOS/Internal_commands.htm#VOL
http://www.rcppmail.org/DOS/Internal_commands.htm#DATE
http://www.rcppmail.org/DOS/Internal_commands.htm#TIME
http://www.rcppmail.org/DOS/Internal_commands.htm#COPY%20CON
http://www.rcppmail.org/DOS/Internal_commands.htm#TYPE
http://www.rcppmail.org/DOS/Internal_commands.htm#COPY
http://www.rcppmail.org/DOS/Internal_commands.htm#REn
http://www.rcppmail.org/DOS/Internal_commands.htm#DEL
http://www.rcppmail.org/DOS/Internal_commands.htm#MD
http://www.rcppmail.org/DOS/Internal_commands.htm#CD3
http://www.rcppmail.org/DOS/Internal_commands.htm#RD
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options:- 

/P  Page wise 

/W  Widths wise 

/S  List all files and directory of subdirectories 

/AH  Display directory with hidden files  

/AS  Display directory with system files 

/AD  Display only directories present in current drive 

3. VER:-(Version) Version numbers indicates that which edition of DOS we are working on. 

Syntax:-  C:\> VER   press enter 

Output:- 
C:\>VER 
Windows 98 [Version 4.10.2222] 

4. VOL:-(Volume) Displays the disk volume label and serial number, if it exist.  

Syntax:- C:\> VOL  press enter 
Output:-C:\>VOL 

 
Volume in drive C is JAI 
Volume Serial Number is 3E42-1907 

5. DATE:- Display the current Date  

Syntax:-  C:\> DATE 
C:\>DATE 
Current date is Fri 02-15-2002 
Enter new date (mm-dd-yy): 

6. TIME:- Display current time 

Syntax:- C:\> TIME 
C:\>TIME 
Current time is 8:38:47.70a 
Enter new time: 

 
Type TIME with no parameters to display the current time setting and a prompt for a new one. Press 
ENTER to keep the same time.  

Note:- We enter the time in the format of 24 hour clock. 

7. PROMPT allows the user to set a new DOS prompt instead of usual C:\> or A:\>; eg C:\> prompt pcc; 
Prompt$p$g - this allows you to reset default prompt; Prompt $d (current date); Prompt $t (current time); 
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8. Echo is a command in DOS, OS/2, Microsoft Windows, Unix and Unix-like operating systems that outputs the 

strings it is being passed as arguments. 

echo Hello world 

Hello world 

File related commands 

9. COPY CON:- This command gives the facility to create a new text file. 

Syntax:-  C:\> COPY CON <Filename> 
C:\>COPY CON Rose.txt 
A clock in a office can never get stolen 
Too many employees watch it all the time 
^Z 
1 file(s) copied 
 

After copy con we must specify a suitable file name. Press enter. Start typing the informations of the file. 
After gathering the information we press ^Z (CTRL+Z) button or F6 button to save the file. After pressing 
enter key computer will show a message like 1 file(s) copied. This means that file is stored in the disk. 
Suppose we don't want to save the file or we just want to abort from file creation job, then we simply press 
^C (CTRL+C) button to abort without saving the file, intend of pressing ^Z button. 

Notes:-  1. Never forget to give a suitable filename 
              2. You can use extension as .TXT for denoting the file as Text file. 

 

10. TYPE:- This command is used to display the contents or text of any file to the display device. 

Syntax:- C:\> TYPE <Filename> 
A:\>TYPE GULAB.TXT 
A clock in a office can never get stolen 
Too many employees watch it all the time 

11. COPY :-  Copy command is used for copy any file to another location or to copy the files to another 
directory. This command may also be used for copying any file to another disk with different file name. 

Syntax:-  C:\> COPY <Source filename> <Target file name> 

 C:\>COPY ROSE.TXT ROSE.MSG 

         1 file(s) copied  
 

12. REN:- (Rename) This command is used to change the name of any file or directory. Syntax:- C:\> REN 
<Source filename> <Target filename> 
C:\>REN ROSE.TXT GULBAL.TXT 
If we get successfully C:\ that means filename or directory name is get changed. Either it will show the error 
message.  

https://en.wikipedia.org/wiki/Command_(computing)
https://en.wikipedia.org/wiki/DOS
https://en.wikipedia.org/wiki/OS/2
https://en.wikipedia.org/wiki/Microsoft_Windows
https://en.wikipedia.org/wiki/Unix
https://en.wikipedia.org/wiki/Unix-like
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To changing the filename present in floppy disk 
C:\>REN A:\ROSE.TXT GULAB.TXT 
Note that you cannot specify a new drive or path for your destination. 

13. DEL:- This command is used for erasing any file from the disk.  

Syntax:- C:\> DEL <Filename> 
C:\>DEL LOTUS.TXT 

If  it successfully erase the file from disk then C:\> prompt will be appear, either computer will show an 
error message.  

Note:- /P option is used for permission before deleting the file.  

Directory related commands 

14. MD:- (Make Directory)- This command allows to create a new directory.  

Syntax:- C:\> MD <Dir name> 
C:\> MD REPORT 
C:\>  

Now this directory can be used for keeping various sort of reports. Under this directory we can create 
another directory which is known as subdirectory.  

15. CD:- (Change Directory):- We can enter or exit from any directory using this command.  

Syntax:- To access any directory 
C:\> CD <Directory name> 
C:\> CD REPORT 
C:\REPORT>  

Prompt will change with the directory name. If we keep two dots after CD command than we will exit from 
the directory.  

Syntax:-C:\> CD.. 
C:\REPORT> CD.. 
C:\>  

16. RD:-(Remove directory):- This command is used when we want to remove any unusable directory form 
our disk. 

Syntax:- C:\> RD <Directory name> 
C:\> RD REPORT 

17. PATH:- This command is used for display or sets directories for executable files. 

Synatx:- C:\> PATH  
This command display current path settings. 
 
C:\> PATH=C:\WINDOWS\COMMAND;C:\WINDOWS\;C:\TC 
this command will sets the directories windows, the command subfolder of windows and TC folder for 
executable files. Operating system will look for executable files in these directories. 

     Example:- C:\> DIR/?  or  C:\> COPY/? 
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18. MOVE:- Move command is used for moving one file or multiple files from one location to another 
location or from one disk to another disk. 

Syntax:- C:\> MOVE  <file name>  <path name> 
C:\SONGS> MOVE   *.MP3   C:\ SONGS\OLD SONGS\ 
 
C:\> 

19.tree 

 The tree command typed alone will produce a tree listing and overview of the current directory.The picture 
is an example of a tree overview when using the tree command by itself.

 

In this example, C: is the current directory, "banners" is one of the many directories in the current directory, 

and "big" is a subdirectory of the "cdn" directory. 

20.IPCONFIG: internet protocol configuration(to display the IP address) 

Ethernet adapter Local Area Connection: 

Connection-specific DNS Suffix . : hsd1.ut.comcast.net. 
IP Address. . . . . . . . . . . . : 192.168.201.245 
Subnet Mask . . . . . . . . . . . : 255.255.255.0 
Default Gateway . . . . . . . . . : 192.168.201.1 

ipconfig /all 

https://www.computerhope.com/jargon/d/director.htm
https://www.computerhope.com/jargon/s/subdirec.htm
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Windows IP Configuration 
 
Host Name . . . . . . . . . : COMPUTERH1 
DNS Servers . . . . . . . . : 123.45.67.8 
111.111.111.1 
111.111.111.1 
Node type . . . . . . . . . : Broadcast 
NetBIOS Scope ID. . . . . . : 
IP Routing Enabled. . . . . : No 
WINS Proxy Enabled. . . . . : No 
NetBIOS Resolution Uses DNS : No 

 

 

Execise: 

1. Compare and contrast windows10 operating system with previous versions of windows. 
2. Advantages of DOS 
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TASK 4 

Troubleshooting 

Hardware Troubleshooting 

1. If you hit the power button & nothing happened. 

 Check all power connections. 

 Check for power on mother board. 

2. If the system turns on but does not beep or begin to boot up. 

 Remove all components except motherboard/ CPU  check by giving power to them 

 

Computer error beeps codes: 
 

o No beep: short, no power, bad CPU/ MD, loose peripherals.  
o One beep: everything is normal & computer posted tax. 
o Two beeps: post / CMOS error. 
o One long been one short beep: Motherboard problem.  
o One long beep two short beep: video problem. 
o One long beep three short beeps: video problem. 
o Three long beeps: keyboard error. 
o Repeated long beep: memory error. 
o Continuous high- low beeps: CPU overheating  

 
 

Software Troubleshooting:  

Error messages encountered during boot before Windows loads 
Ensure that your computer BIOS settings are correctly configured to the hardware that is 

installed in your computer 

The next time you have a software problem, try these troubleshooting tips in the order they're listed below. 

Carefully document the steps you take. That way, if a tech support call becomes necessary, at least you'll have 

a good idea of what isn't causing the problem. 

1. Free up RAM by closing other open programs. 

2.  Restart the software. 

3.  Shut down and restart your computer. 

4. Use the Internet to find help.  

• Search for answers 

• Check the vendor's website 

• Check other websites 
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5.  Undo any recent hardware or software changes. 

6. Uninstall the software, then reinstall it. 

7.  Look for software patches. 

8. Scan for viruses and malware. 

9.  Check for a firewall conflict. 

10.  Boot up in Safe Mode. 

11. Defragment your hard drive. 

 

Exercise: 

Write in detail about hardware and software trouble shooting steps 
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TASK 5 

A. Web Browsers and Surfing the Web 

 

Procedure: 

Web browser provides the means to the searching and also helps to download the web content. 

Web browsers support most of the famous Internet Protocols like HTTP, FTP. 

Common file formats a browser accepts are HTML 

Well known browsers natively support a variety of other formats in addition to HTML such as 

JPEG, PNG, GIF image formats 

Different web browsers available in the market are: 

 Google Chrome  

 Internet Explorer 

 Netscape 

 Mozilla 

 Opera 

 Lynx 

 Safari 

 
Bookmark: Each web browser is built-in with the support of Internet Bookmarks which serve 

as a named anchor – primarily to URLs. The primary purpose of this book mark is to easily 

catalog and access web pages that the web browser user has visited or plans to visit, without 

having to navigate the web to get there. 

Pop-up Blockers: 

 
Pop-ups are a form of online advertising on the WWW intended to attract the attention of the 
users. These pop ups are hosted on the web sites which are frequently visited by the netizens. 
These pop ups are activated when these web sites open a new web browser window and there by 
displaying the advertisements  
A plug-in is a software component program that interacts with a main application to provide a 
better integration of the media. The basic difference between application programs and plug-ins 
is that multimedia files are launched in a separate window where as in plug-ins multimedia play 
in the browser window. 

Few famous Plug-ins are: 

 
 Apple Quick Time 

 Macromedia flash 
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 Microsoft Media Player 

 Adobe Shockwave 

 Sun Micro systems Java Applet  
 

 

 

LAN Proxy Settings: 

 
 select tools menu in Internet Explorer 

 Select Internet Options 

 Select Connections 

 You end up in two options 

1. Dial-up and virtual network settings 

2. LAN setting 

The selection at this step is dependent on the kind of connection you are trying to configure.  

They are: 

 Dial-up modem connection 

 LAN connection 

 DSL or Cable modem 

B. How to access the websites, email and Search Engines, various threats on the internet 

and would be asked to configure their computer to be safe on the internet, Antivirus 

downloads to avoid viruses and/or worms. 

 

A search engine can be defined as a web site with tools which help you to find information on 

the internet. 

Limitations: 

 
 They filter results according to the information that a particular user has given them, which rarely 

provides an accurate reflection of a user’s real interests. 
 

 Although it is less of a problem than it used to be, search engine rankings have always been 
manipulated by keyword–stuffing: the inclusion of unnaturally large numbers of search terms 
into web pages. 

 

 Rankings are almost certainly affected in some way by the search engine companies’ commercial 
interests: their dependence on paid advertising, and their promotion of their own products. 
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 You can select the search terms 

 You can use the same search terms with multiple search engines 

 You can change search terms as much as you wish 

 You will normally receive numerous links 

 Its fast 

Cons: There are so many different search engines it may be difficult to choose 

 You will normally receive too many links often making it difficult to identify the 

most relevant sites. 

 The vast majority of links may be only marginally relevant or altogether irrelevant 
 

 Alta Vista 

 Ask Jeeves 

 Google 

 Lycos Etc. 

Meta Search Engines: 

 

Meta search engines or “met crawlers” don’t crawl the web themselves. Instead they search the resources 

of multiple search engines by sending a search to several search engines at once aggregating the result. 

Pros: 

 
 You only need to use one search tool which is time- efficient 

  You only need to learn how to use one search engine reducing learning curve 

 You benefit from the difference among several search tools at once 

 
Cons: 

 
 Meta search services may not be able to leverage each individual search engines full 

range of query tools resulting in less refined searches 

 You cannot personally select the search engines queried by meta search services. 

   Viruses and/or worms 
 

Antivirus: Antivirus software is a program that either comes installed on your computer or that you 
purchase and install yourself. It protects your computer against most viruses, worms, Trojan horses and 
other unwanted invaders that can make your computer sick. 
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Firewall: 
 

A firewall is a special software or hardware designed to protect a private computer network from 

unauthorized access. A firewall is a set of related programs located at a network gateway server which 

protects the resources of the private network from users from other networks. 

Installing Symantec antivirus for Windows: 

 Insert Symantec antivirus CD into your CD drive 

 Double click on the Symantec-setup.exe 

 The installer will open 

 Click next to proceed 

License agreement will open .Click I accept the terms of the license agreement and then click next. 

 Follow the instruction on the screen to complete the installation. Get Computer Updates: 

 Click start> settings>control panel 

 Click Automatic Updates icon to open Automatic Updates dialog box 

 Check the box Keep my computer up to date 

   Choose a setting 

Click OK Block Pop ups: 

 In the IE open tools>pop-up blocker 

 Click on Turn on Pop- up blocker Windows Firewall: 

 Go to Start>control panel>Network and Internet Connections>windows firewall 

 In the general tab check the On(recommended) box 

 If you don’t want any exceptions check on Don’t allow exceptions box 

A test which simulates all of the above tasks would be crafted and given to the students. 
 

 Identify and explain the components required to establish a network 

 Establish internet connection and create a new email id , send mail and attachment file to other mail 

account 

 Define search engine. List the various search engines. Navigate through any of the search engine like 

Google and explore its features. 

 Download a file from the internet. Write the various steps involved in downloading 

 What is Antivirus software? List a few popular anti-virus kits available. 

 Explain the functionality of the firewall quoting a few examples. 

 

Exercise: 

Students customize their web browsers with the LAN proxy settings, book marks, search toolbars and 

pop up blockers 
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TASK 6 

Word Orientation: an overview of Microsoft (MS) office 2007/ 10: 

Importance of MS office 2007/10, overview of toolbars, saving files, Using 

help and resources, rulers, format painter. 

 

INTRODUCTION TO MS-OFFICE 

 

Microsoft office is a set of inter related desk top applications ,servers and services, collectively refers to 

as an office suit for the micro soft windows and MAC OSX operating systems . 

 

MS WORD: 

 

Microsoft Word is a word processing software package. We can use it to type letters, reports, and other 

documents. In Word 2007, how a window displays depends on the size of your window, the size of your 

monitor and the resolution to which your monitor is set. Resolution determines how much information 

your computer monitor can display. 
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STARTING MS WORD:- 

 
Two ways of starting MS WORD:- 

 
Double click on Microsoft word icon on the desk top. Click on start ->programs->ms office ->ms word. 

  

The Microsoft Office Button 

 
In the upper-left corner of the Word 2007 window is the Microsoft Office button. When you click the 

button, a menu appears. You can use the menu to create a new file, open an existing file, save a file, and 

perform many other tasks. 

 

        The Quick Access Toolbar 

 
The Quick Access toolbar provides you with access to commands you frequently use. By default Save, 

Undo, and Redo appear on the Quick Access toolbar. You can use Save syour file, Undo to rollback an 

action you have taken, and Redo to reapply an action you have rolled back. 
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The Ribbon 

 

We use the Ribbon to issue commands. The Ribbon is located near the top of the screen, below the 

Quick Access toolbar. At the top of the Ribbon are several tabs; clicking a tab displays several 

related command groups. Within each group are related command buttons. You click buttons to 

issue commands or to access menus and dialog boxes 

The Ruler 

 
We can use the ruler to change the format of your document quickly 
 

The Text Area 

 
You type your document in the text area. The blinking vertical line in the upper-left corner of the text is the 

cursor. 

 The Status Bar 

 
The Status bar appears at the very bottom of your window and provides such information as the current 

page and the number of words in your document. 
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A. By Using Word create project certificate. Features to be covered:-Formatting 

Fonts in word, Drop Cap in word, Applying Text effects, Using Character Spacing, 

Borders and Colors, Inserting Header and Footer, Using Date and Time option in 

Word. 

The graphical user interface (GUI) provides ways to apply the various font formatting options (or 

character formatting options) to your text. In Word 2010 and Word 2007, many of these options are 

displayed directly in the Font group on the Home tab of the Ribbon and on the contextual toolbar that 

appears when you right-click within text.  Additional options are   available in   the Font dialog box, 

which you can open by clicking the Font dialog box launcher ( ) in the lower right-hand corner of the 

Font group on the Home tab. In Word 2003, many of these options are displayed directly on the 

Formatting toolbar, and additional options are available in the Font dialog box, which you can open by 

right-clicking and then clicking Font ( ) on the context-sensitive menu that opens or by clicking Font 

on the Format menu. The Font dialog box has two tabs. 

Font 

 
Character Spacing 

 
The font formatting options that you can configure on the Font tab in the Font dialog box influence the 

appearance of the individual characters in your text. 
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A drop cap is a specially formatted letter that appears at the beginning of a paragraph. Word 2007 

offers two styles of drop caps. The first, and more common, begins the paragraph with a large letter that 

spills down into the text. Thus, the drop cap displaces the first few lines of the paragraph. The second 

style places the large first letter in the margin adjacent to the paragraph. 

Add an effect to text 

 
Select the text that you want to add an effect to. 

 
On the Home tab, in the Font group, click Text Effect. 

 

 
Click the effect that you want. 

 
For more choices, point to Outline, Shadow, Reflection, or Glow, and then click the effect that you 

want to add. 

Remove an effect from text 

 
Select the text that you want to remove an effect from. 

 
On the Home tab, in the Font group, click Clear Formatting. 
 

 

 
If you want to add a graphic or text at the top or the bottom of your document, you need to add a header 

or footer. You can quickly add a header or a footer from the galleries, or you can add a custom header 

or footer. 

You can use these same steps to add a header or footer without page numbers 

Add a header or footer from the gallery 

On the Insert tab, in the Header & Footer group, click Header or Footer. 
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Click the header or footer that you want to add to your document. 

 
To return to the body of your document, click Close Header and Footer on the Design tab (under 

Header & Footer Tools). 

 

 
Click where you want to insert the date or time. 

 
On the Insert tab, in the Text group, click Quick Parts. 

 

 
Click Field. 

 
In the Categories box, click Date and Time. 

 
In the Field names box, click Create Date, Print Date, or Save Date. 

 
In the Date formats box, click the date and time format that you want — for example, 2/12/2018 9:45 PM 

or 12 February 2018 

Creating project abstract Features to be covered:-Formatting Styles, Inserting table, Bullets and 

Numbering, Changing Text Direction, Cell alignment, Footnote, Hyperlink, Symbols, Spell Check, 

Track Changes. 

To create a document applying the above mentioned techniques.  

Table: A table consists of rows and columns.  

Cell Alignment: Aligns contents written in a table in the top left corner or top right corner or in the 
center etc.  
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Foot Note: Foot notes are used to specify comments or provide references for text in a document. 
Hyperlink: It is a colored and underlined text or a graphic that you click to go to a file, a location in a 
file, an HTML page on the World Wide Web, or an HTML page in an intranet. 

Symbols: You may not be able to enter certain symbols into your word document, as there is a 
limitation on the keys on the key board. Creating new symbols especially when working with 
mathematical terms becomes very difficult. 

Spell check: It automatically checks for spelling and grammatical errors. 

Bullets and Numbering: In Microsoft word we can easily create bulleted or numbered list of items. 
Formatting Styles: 

Changing Text direction: You can change the text orientation in drawing objects, such as text boxes, 
shapes, and callouts, or in table cells so that the text is displayed vertically or horizontally. 

Track changes: Track changes are an excellent feature of Microsoft word as it enables a user or 
reviewer to keep track of the changes that have taken a period. Changes like insertion, deletion or 
formatting changes can be kept track of. 

 

Table: 
1. Click where you want to create a table. 

2. On the Table menu, point to Insert, and then click Table. 

3. Under Table size, select the number of columns and rows. 

4. Under AutoFit behavior, choose options to adjust table size. 

5. To use a built-in table format, click AutoFormat. 

 
Select the options you want Cell Alignment: 

1. Click the cell that contains text you want to align. 
 On the Tables and Borders toolbar, select the option for the horizontal and vertical     alignment .you 

want for example, Align Bottom Center or Align Top Right. 

Foot Note: 

1. In print layout view, click where you want to insert the note reference mark. 

2. On the Insert menu, point to Reference, and then click Footnote. 

3. Click Footnotes or Endnotes. 

 
By default, Word places footnotes at the end of each page and endnotes at the end of the document. You 

can change the placement of footnotes and endnotes by making a selection in the Footnotes or Endnotes 

box. 

 

4. In the Number format box, click the format you want. 
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5. Click Insert. 

 
Word inserts the note number and places the insertion point next to the note number. 

 
6. Type the note text. 

7. Scroll to your place in the document and continue typing. 

 
As you insert additional footnotes or endnotes in the document, Word automatically applies the correct 

number format. 

Hyper link: 
 

Create a hyperlink to a file on your computer 
1. Select the text or picture that you want to display as a hyperlink. 

2. On the Insert tab, click Hyperlink.  
3. Under Link to, do one of the following: 

To link to an existing file, click Existing File or Web Page under Link to, and then find the file in 

the Look in list or the Current Folder list. 

 

 

 

To create a new, blank file and link to it, click Create New Document under Link to, type a name for the new 

file, and either use the location shown under Full path or browse to a different save location by clicking Change. 

You can also choose whether to Edit the new document later or open and Edit the new document now. 

 

Create a hyperlink to a location in the current document 

1. Select the text or picture that you want to display as a hyperlink. 

2. On the Insert tab, click Hyperlink  

You can also right-click the text or picture and click Hyperlink on the shortcut menu. 

3.Under Link to, click Place in This Document. 
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Create hyperlink to a location on the web 

1. Select the text or picture that you want to display as a hyperlink. 

2. On the Insert tab, click Hyperlink.  

You can also right-click the text or picture and click Hyperlink on the shortcut menu. 

3. In the Insert Hyperlink box, type or paste your link in the Address box. 

Symbol: 

1. Click where you want to insert the symbol. 

2. On the Insert menu, click Symbol, and then click the Symbols tab. 

3. In the Font box, click the font that you want. 

4. Double-click the symbol that you want to insert. 

5. Click Close 

 

Spell check:  
 

On the Standard toolbar, click Spelling and Grammar. 
When Word finds a possible spelling or grammatical problem, make your changes in the Spelling and Grammar 

dialog box. 

Bullets and Numbering: 

 
1. Type 1.to start a numbered list or * (asterisk) to start a bulleted list, and then press SPACEBAR or 

TAB. 

2. Type any text you want. 

3. Press ENTER to add the next list item (Word automatically inserts the next number or bullet). 
4. To finish the list, press ENTER twice, or press BACKSPACE to delete the last bullet or number in 

the list 

 
Formatting Styles: 

 
1. Select the words, paragraph, list, or table you want to change. 

If  the  Styles  and  Formatting task pane is not open, click Styles and Formatting on the Formatting 
Toolbar. 

2.Click the style you want in the Styles and Formatting task pane. 
If the style you want is not listed, click All Styles in the Show box  
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Track Changes: 

 
1. Open the document you want to revise. 

2. On the Tools menu, click Track Changes 
 

Changing Text direction: 

 
1. Click the drawing object or table cell that contains the text you want to change. 

2. On the Format menu, click Text Direction. 
Click the orientation you want 

          Description about MS-word: 

 

To create news Letter Microsoft Word is a popular and commonly used word 

processing   program. It is one of the most popular word processing programs, if not the most 

popular. Microsoft Word is often used in businesses, schools and universities. 

Procedure 

Microsoft Word is a popular and commonly used word processing program. It is one of the 

most popular word processing programs, if not the most popular. Microsoft Word is often 

used in businesses, schools and universities. 

Table of contents: 

 
Table of contents displays a list of headings in a created document. It basically provides 

an outline of the entire document created format. 

Newspaper columns: 

 
One can create a newspaper columns document by specifying the number of new 

letter-style column required and then adjust their width, and add vertical lines between columns. 

Images from files and clipart: 

 
Inserting a picture (graphic) from a file and clipart may be required for a document. 

This picture could be a scanned photograph or any other digitally produced one. These pictures can 

be modified, resized, cropped and enhanced. 

Drawing toolbar and Word Art: 
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One can create his/her own drawings in Microsoft word Provides a full fledged 

drawing tool bar. Word Art in Microsoft word enables you to create special and decorative text. 

Formatting Images, Textboxes and Paragraphs: 

 

Formatting an image includes selecting appropriate color, size, layout and cropping. Generally the 

text in a document follows a standard orientation (line after line). A text box provides a different 

orientation to the text with in a document. It can arrange the text in anywhere and can be resized and 

moreover moved to any section of the document or even outside. 

When you are formatting a paragraph, you do not need to highlight the entire paragraph. Placing the 

cursor anywhere in the paragraph enables you to format it. After you set a paragraph format, 

subsequent paragraphs will have the same format unless you change the format.     

Procedure: 

 

Table of contents: 

 
1. Click where you want to insert the table of contents. 

2. On the Insert menu, point to Reference, and click Index and Tables. 

3. Click the Table of Contents tab. 

4. To use one of the available designs, click a design in the Formats box. 

5. Select any other table of contents options you want. 

 
Newspaper columns: 

1. Select the entire or part of document to be converted into a newsletter-style 

 
2. Click on format menu , select columns 

 
3. Any desired number of columns are presets-one or two or three or left or right b\can be selected. 

 
4. Width and spacing can be fixed and equal columns width can be checked for uniformity 

 
5. If a newspaper columns are to be separated by a line, then check line between 

 
6.    Under apply to will be whole document if entire document is selected else we have to select a 
selected text. 

 

7. Click ok  
Inserting images from files and clip art: 

1. Click where you want to insert the picture. 

2. On the Insert menu, point to Picture, and then click From File. 

3. Locate the picture you want to insert. 
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4. Double-click the picture you want to insert. 

 
 
 

Clip Art: 

 
1. On the Insert menu, point to Picture, and then click Clip Art. 

2. In the Clip Art task pane, in the Search for box, type a word or phrase that describes the clip 

you want or type in all or some of the file name of the clip. 

3. To narrow your search, do one or both of the following: 

                To limit search results to a specific collection of clips, in the Search in box, click the 

arrow and select the collections you want to search.To limit search results to a specific type of 

media file, in the Results should be box, click the arrow and select the check box next to the 

types of clips you want to find. 

4. Click Go. 
5. If you don't know the exact file name, you can substitute wildcard characters for one or more real 

characters. Use the asterisk (*) as a substitute for zero or more characters in a file name. Use the 

question mark (?) as a substitute for a single character in a file name. 

6. In the Results box, click the clip to insert it. 

 
Drawing Toolbar and Word Art: 

1. Click in your document where you want to create the drawing. 

2. On the Insert menu, point to Picture, and then click New Drawing. 
       A drawing canvas is inserted into your document. 
3. Use the Drawing toolbar to add any shapes or pictures that you want. 

 

Word Art: 
On the Drawing toolbar, click Insert WordArt 

Click the WordArt effect you want, and then click OK.  

1. In the Edit WordArt Text dialog box, type the text you want. 
2. Do any of the following: 

 
To change the font type, in the Font list, select a font. 

To change the font size, in the Size list, select a size. 

 To make text bold, click the Bold button. 

 To make text italic, click the Italic button. 

3.  Formatting Images: 
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               Formatting of the images can be achieved by selecting the image and double click on the   

picture, format picture dialog box appears. 

The same can be achieved by selecting the tools menu > customize>tool bars tab>picture and click 
close. Basic formatting features of an image 

 
Resize a drawing 

1. Select the drawing canvas 

2. On the Drawing Canvas toolbar, do one of the following: 

                To make the drawing canvas boundary larger without changing the size of the objects on the  

                   canvas, click Expand . 

                 To make the drawing canvas boundary fit tightly around the drawing objects or pictures,  

                    click Fit . 

          To scale the drawing and make the objects and canvas proportionately smaller or larger,  

          click Scale Drawing, and then drag the edges of the canvas. 

 

Resize a picture or shape 

1. Position the mouse pointer over one of the sizing handles 

2. Drag the sizing handle until the object is the shape and size you want. 

 
To increase or decrease the size in one or more directions, drag the mouse away from or toward the 

center, while doing one of the following: 

 

 To keep the center of an object in the same place, hold down CTRL while dragging the mouse. 

 To maintain the object's proportions, drag one of the corner sizing handles. 

 To maintain the proportions while keeping the center in the same place, hold down CTRL while 

dragging one of the corner sizing handles. 

Crop a picture: 

1. Select the picture you want to crop. 
2. On the Picture toolbar, click Crop . 

3. Position the cropping tool over a cropping handle and then do one of the following: 

 To crop one side, drag the center handle on that side inward. 

 To crop equally on two sides at once, hold down CTRL as you drag the center handle on either side 

inward. 

 To crop equally on all four sides at once, hold down CTRL as you drag a corner handle inward. 

4. On the Picture toolbar, click Crop to turn off the Crop command. 
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Text Box: 

 
1. On the Drawing toolbar, click Text Box . 

2. Click or drag in your document where you want to insert the text box 

3. You can use the options on the Drawing toolbar to enhance a text box— for example, to 

change the fill color— just as you can with any other drawing object 

 

Paragraphs: 

 
Change line spacing 

Select the text you want to change. 

 
 On the Formatting toolbar, point to Line Spacing, and then do one of the following: 

 To apply a new setting, click the arrow, and then select the number that you want. 

 To apply the most recently used setting, click the button. 

 To set more precise measurements, click the arrow, click More, and then select the options you want 

under Line Spacing. 

 

Change spacing before or after paragraphs 

 
1. Select the paragraphs in which you want to change spacing. 

2. On the Format menu, click Paragraph, and then click the Indents and Spacing tab. 

3. Under Spacing, enter the spacing you want in the before or after box. 
 

Change paragraph direction 

 
1. Place the insertion point in the paragraph that you want to change, or select several paragraphs. 

2. Do one of the following: 

 To have text begin from the left, click Left-to-Right on the Formatting toolbar. 

  To have text begin from the right, click Right-to-Left on the Formatting toolbar. 

 
1. When you change the paragraph direction, Microsoft Word leaves justified and centered text as it is. 

In the case of left-aligned or right-aligned text, Word flips the alignment to its opposite. For example, 

if you have a left-to-right paragraph that is right aligned, such as the date at the top of a letter, clicking 

Right-to-Left results in a right-to-left paragraph that is left aligned 
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TASK 7 

 

Excel Orientation: The importance of MS office 2007/10 tool Excel as a 

Spreadsheet tool, Accessing, overview of toolbars, saving excel files, Using 

help and resources. 

Introduction to MS-Excel 

 
Excel is a computerized spreadsheet, which is an important business tool that helps you 

report and analyze information. Excel stores spreadsheets in documents called workbooks. 

Each workbook is made up of individual worksheets, or sheets. Because all sorts of 

calculations can be made in the Excel spreadsheet, it is much more flexible than a paper 

spreadsheet. The Excel window has some basic components, such as an Active cell, Column 

headings, a Formula bar, a Name box, the mouse pointer, Row headings, Sheet tabs, a Task 

Pane, Tab scrolling buttons and Toolbars. 

Sample Worksheet 
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Excel worksheet and workbooks 

 
When you set up calculations in a worksheet, if an entry is changed in a cell, the spreadsheet 

will automatically update any calculated values that were based on that entry. When you open 

Excel, by default it will open a blank workbook with three blank worksheets. When you save 

a workbook, you have a Save As option that can save the spreadsheet to earlier versions of 

Excel or to Quattro Pro, Lotus 123 formats, dBase formats, and even to a comma or tab-

delimited text file. 

Identify Excel components 

To navigate within a workbook, you use the arrow keys, Page Up, Page Down, or the Ctrl key 

in combination   with the arrow keys to make larger movements. The most direct means of 

navigation is with your mouse. 

Scroll bars are provided and work as they do in all Windows applications. To move to other 

Worksheets, you can: 

A. Click their tab with the mouse 

 
B. Use the Ctrl key with the Page Up and Page Down keys to move sequentially up or down      

through the worksheets. 

If you are familiar with Microsoft Access, you will find the tab scrolling buttons for 

moving between worksheets to be similar to record browsing on an Access form or 

datasheet. Developing a Worksheet 

 Determine the worksheet’s purpose. Enter the data and formulas. 

 Test the worksheet and make any necessary edits / corrections.  
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 Document the worksheet and improve appearance. 

 Save and print the complete worksheet. 

 

Entering data into a worksheet 

 
To enter data, first make the cell in which you want to enter the data active by clicking it. 

Enter the data (text, formulas, dates, etc.) into the active cell. 

Use the Alt + Enter key combination to enter text on multiple lines within the same cell. Use 

TAB 

Key, arrow keys, or ENTER key to navigate among the cells. 

Entering Formulas 

 
A formula is a mathematical expression that calculates a value. In Excel, formulas always 

begin with an equal sign (=). 

A formula can consist of one or more arithmetic operators. 

 
The order of precedence is a set of predefined rules that Excel follows to calculate a formula. 
 

Resize worksheet rows and columns 

 
There are a number of methods for altering row height and column width using the mouse or 

menus: 

Click the dividing line on the column or row, and drag the dividing line to change the 

width of the column or Height of the row Double-click the border of a column heading, 

and the column will increase in width to match the length of the longest entry in the 

column Widths are expressed either in terms of the number of characters or the number 

of screen pixels. Identify cell ranges 

 
A group of worksheet cells is known as a cell range, or range. 

 
 Working with ranges in a worksheet makes working with the data easier. 

 
 Ranges can be adjacent or nonadjacent. 

 
 An adjacent range is a single, rectangular block of cells 
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 Select an adjacent range by clicking on a cell and dragging to an opposite corner of a 

rectangle of cells 

 A nonadjacent range is comprised of two or more adjacent ranges that are not contiguous 

to each other 

 .To select a nonadjacent range, begin by selecting an adjacent range, then press and hold 

down the Ctrl key as you select other adjacent ranges 

Select and move worksheet cells 

 
To select a large area of cells, select the first cell in the range, press and hold the Shift key, 

and then click the last cell in the range. 

Once you have selected a range of cells, you may move the cells within the worksheet by 

clicking and dragging the selection from its current location to its new one. 

By pressing and holding the Ctrl key as you drag, Excel will leave the original selection in its 

place and paste a copy of the selection in the new location. To move between workbooks, use 

the Alt key while dragging the selection. 

 

Insert worksheet rows and columns 

 

You can insert one or many additional rows or columns within a worksheet with just a few 

steps using the mouse or menu options. You can insert individual cells within a row or 

column and then choose how to displace the existing cells.  You can click the Insert menu and 

then select row or column, or right click on a row or column heading or a selection of cells 

and then choose Insert from the shortcut menu. Delete worksheet rows and columns 

 
To delete and clear cells, rows, or columns, you can use the Edit menu, or right click on a 

heading or a selection of cells and choose Delete from the shortcut menu.  Clearing, as 

opposed to deleting, does not alter the structure of the worksheet or shift unclear data cells. 

What can be confusing about this process is that you can use the Delete key to clear cells, but 

it does not remove them from the worksheet as you might expect. 
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Use undo and redo features 

Editing is an intrinsic task in any document, and especially useful are the Undo and Redo 

actions. The Undo feature allows you to sequentially back up to a certain action, such as a 

delete, a move, an entry, etc.  Allows you to reverse those actions. Redo allows you to 

reapply actions one step at a time that you have previously undone. 

Print as workbook 

 
To print a worksheet, you can use: A menu 

The Print button on the standard toolbar 

 
The Ctrl-P keystroke to initiate a printout of the worksheet 

a) Calculating GPA - Features to be covered:- Cell Referencing, Formulae 

in excel – average, std. deviation, Charts, Renaming and Inserting 

worksheets, Hyper linking, Count function, LOOKUP/VLOOKUP, Sorting, 

Conditional formatting . 

Procedure: 

1. On the chart menu click chart type 

2. Text direction. 

Click the arrow down next to the text direction button. For right to left click right to left. For 

left to right reading order, click left to right. 

For reading order that is consistent with the language of the first entered character, click 

context. For reading order that is inconsistent with the language of the first entered character, 

click control. 

3. In the tools menu click options and then click chart tab. 

 
4. To show all worksheet data in the chart even if some rows and columns are hidden, clear 

the plot visible cells by check box. 

5. To prevent hidden rows and columns from displaying in the chart, select the plot cells 

only check box. 

Hyper Linking: 

 
1. Create a worksheet: On the file menu, click new, and then click blank workbook task 
pane. 
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2. Insert a worksheet: C lick worksheet on the insert menu. Right click on sheet tab and 

then click insert double click the template for the type of sheet you want. 

3. Hyperlink: Using hyperlink we can insert one more sheet in the present sheet 
 

4. Count function: Create a blank worksheet press control +c. In the worksheet select cell A 

and press control +c. On the tools menu point to formula auditing and then click formula 

auditing menu. 

Worksheet: 

 
1. In the file menu go to menu then a new worksheet is created. 

 
2.    To add a single worksheet, click worksheet on the Insert menu. To add multiple 

worksheets hold down shift and then click the number of worksheet tasks to add in an open 

workbook 

Sort: 
1. Click a cell in the list you want to sort. 

2. On the Data menu click sort. 

3. Under first key sort click the custom sort order you want and then click ok. 

4. Click any other sorting option you want. 
 

Formulae in Excel: 

S.No Formula & Description 

1 AVERAGE( ) 

The average of a list of cells 

2 
COUNT( ):The number of items in a list of cells 

3 
MAX( ) 

The largest value in a list of cells 
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Charts: 

1. Get your data into Excel. First, you need to input your data into Excel.  

2. Choose a type of chart/graph to create. ... 

3. Switch axes, if necessary. ... 

4. Adjust your labels and legends, if desired. ... 

5. Change the Y axis measurement options, if desired. ... 

6. Reorder data, if desired.

 

 

 

 

4 
MIN( ) 

The smallest value in a list of cells 

5 
PRODUCT( ) 

The multiplication of a list of cells 

6 
SUM( ) 

The sum of a list of cells 
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TASK 8 

 

Basic power point utilities and tools which helpful to create basic power point 

presentation. Topic covered during this includes PPT Orientation, Slide Layouts, 

Inserting Text, Word Art, Formatting Text, Bullets and Numbering, Animations, 

Auto Shapes, Lines and Arrows in Power point. 

Introduction to MS- PowerPoint 

 

Microsoft PowerPoint is the name of a proprietary commercial software presentation program 

developed by Microsoft. It was developed by Microsoft and officially launched on May 22, 1990 

PowerPoint is an application used for the creation of presentations. These presentations are laid out 

in a "storyboard" type fashion, where individual slides are created and formatted with text and 

images. The PowerPoint allows you to choose from a wide variety of formats that include sections 

such as titles, lists, images, or charts. Any of these can be incorporated into your presentation.  

a) Create the presentation using the following tools. 

1. Formatting: Color, font type, font size, font style etc. 
2. Header and Footer 
3. Bullets and Numbering 
4. Drawing Toolbar: Auto shapes, Textboxes, etc 
5.  Design Template 
6. Introduction to custom animation. 

 

Insert text: 

 
1. Text can be added to layout. 

2. Align text in the top, middle or bottom of a cell. 

3. Align text on the right or left, or in the center of a cell. 

4. Change cell margins. 

5. Insert a tab in a table. 

6. To make the symbol command available, in normal view, place the insertion point 
on the outbox tab or in a text place holders on the slide. 

7. On the insert menu, click symbol. 

 

8. To change fonts, click a name in the font box.  
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Bullets and numberings: 

1. Select the lines of text that you want to add bullets or numbering to. 
Click bullets or numbering. 

Autoshapes: 

 
1. Select the auto shape that has the text you want to position. 

2. Double-click the selection rectangle of the auto shape or text box and then click the text 

box tab in the format dialog box. 

3. In the text anchor point box, click the position you want the text to start in. LINES AND 

Animations: 

1. Select the object that you want to animate. 

2. On the Animations tab of the ribbon, in the Animation group, click the More button, 
and then select the animation effect that you want. 

  
 

b) Create a presentation to conduct a creativity session using the following tools. 

1. Slide transition 

2. Master slide view 

3. Insert picture – clipart, image 

4. Action button 

5. Drawing tool bar – lines, arrows 

6. Hyperlink 

7. Custom animation 

8. Hide slide 

9. Wash out 

 

Slide transition 

Transitions are easy to add to your slide by using PowerPoint's Transitions Gallery. 

1. Select the slide you wish to add a transition to. 
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2. In the Animations tab under the Transition to This Slide group choose an effect from the Transition 

gallery. Use the arrow to scroll through the options. PowerPoint will show you a preview of the transition 
when you how ever your mouse over a gallery item. 

3. To set 
the speed of a transition, select a speed from the Transition Speed pull-down menu. 

4. OPTIONAL: If you wish to add a sound effect to your transition (again, use this sparingly!) choose a preset 
sound from the Transition Sound pull-down menu or choose "Other Sound" to use a sound from your 
computer. PowerPoint also provides an option to loop your chosen sound. 

5. OPTIONAL: If you want to apply your transition settings to all of your slides, click Apply To All. 
6. OPTIONAL: You also have the option to customize how your slide advances. You can advance slides by 

clicking the mouse of the "On Mouse Click" option is checked, or choose to have your slide automatically 
advance after a certain time. You can even have both options checked so that you can advance the slide early if 
you need. 

Removing Transitions 

1. Select the slide(s) from which you would like to remove the transition. 
2. On the Animation tab in the Transitions gallery choose No Transition  

 

Master Layouts: 

 
1. On the view menu, point to master, and then click slide master. 
 

2. To insert a slide master, do the presentation given in slides and lastly add date and footer 

to the slides. 

 

Insert Images: 

1. Click where you want to insert the picture. 

2. On the drawing tool bar, click insert picture. 

3. Locate the folder that contains the picture that you want to insert, and then click the 

picture file. 

 
 

Clip Art: 

 
1. On the insert menu, point to structure and then click clipart. 

2. In the clipart task pane, in the search for box, type a word or phrase that describes the 

clip, you want to type in all or some of the file menus of the clip. 

In the results box, click the clip to insert it. Action button 
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1. On the View menu, point to Master Views, and then click Slide Master. 
2. On the Home tab, in the Insert group, click Shapes, point to Action Buttons, and then click the action 
button that you want. 

3.  Drag across the location in the 
slide where you want the button to appear. 

Tip: To change the size of the action button, drag a corner until the button is the size that you want. To keep the 

button width and height proportions the same, hold down SHIFT as you drag. 

In the Action Settings dialog, select how to initiate the action by doing one of the following: 

 

Arrows: 

1. In Microsoft power point, double click the chart. 

2. Double click the chart item you want to change. 

3. On the patterns tab, do one or both of the following. 

4. To change the colors, patterns or lines, select the options you want. 

To specify a fill effect, click fill effect and then select the options you want on the gradient, 
text patterns or picture tabs.  
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Hyperlink: 

 
1. Select the text or object that you want to represent the hyperlink. 

2. Click insert hyperlink. 

3. Under link to, click place in this document.  

4. Animations: 

3. Select the object that you want to animate. 

4. On the Animations tab of the ribbon, in the Animation group, click the More button, 
and then select the animation effect that you want. 

 

 Wash out 

Step 1 

Insert the picture by clicking the slide to which you want to add the picture, then click "Insert." Point to 
"Picture" and then click "From File." This opens the "Open" dialog box. Browse to the picture you want 
to insert and double-click it or click "Open." 
Step 2 

Right-click the inserted picture and click "Format Picture" from the pop-up menu. Click the "Picture" tab, 
then click the "Color" box arrow and select "Washout." 
Step 3 

Right-click the picture and select "Save As Picture." Save the picture in a location that can be easily 
accessed. 
Step 4 

Delete the picture from the slide by clicking the picture and pressing the "Delete" key on the computer's 
keyboard. 
Step 5 
Click "Format," then click "Background." Click "Background Fill," then click "Fill Effects." Click the 
"Picture" tab, then click "Select Picture." Navigate to the saved picture, click "Insert," click "OK" and 
then click "Apply" to insert it. The picture will appear as a washout, which looks faded in comparison to 
its original appearance. 
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Hide slide 

 

Select the correct slide. On the left side of your screen, you should see a list of all the slides in your presentation. 

Click the one you wish to hide. 

 If you have successfully selected a slide, a box will appear around that slide. 

 

  

Click Hide Slide. From the options within the Slide Show tab, find and click on the Hide Slide button. These 

options should be located near the top of the PowerPoint window. 

 If you have successfully hid a slide, there will be a slash over the number correlated with the hidden slide. 

 Repeat this process to hide multiple slides. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

MRCET  Page 64 

 

Department of IT/CSE IT Workshop Lab Manual  

TASK 9 

 

a) Introduction to HTML & Basic HTML tags 

HTML is the standard markup language for creating Web pages. 

 HTML stands for Hyper Text Markup Language 
 HTML describes the structure of Web pages using markup 
 HTML elements are the building blocks of HTML pages 
 HTML elements are represented by tags 
 HTML tags label pieces of content such as "heading", "paragraph", "table", and so on 
 Browsers do not display the HTML tags, but use them to render the content of the page 

 

A Simple HTML Document 

Example 

<!DOCTYPE html> 

<html> 

<head> 

<title>Page Title</title> 

</head> 

<body> 

<h1>My First Heading</h1> 

<p>My first paragraph.</p> 

</body> 

</html> 

 

 The <!DOCTYPE html> declaration defines this document to be HTML5 

 The <html> element is the root element of an HTML page 

 The <head> element contains meta information about the document 

 The <title> element specifies a title for the document 

 The <body> element contains the visible page content 

 The <h1> element defines a large heading 

 The <p> element defines a paragraph 

HTML Tags 

HTML tags are element names surrounded by angle brackets: 

<tag name>content goes here...</tag name> 

 HTML tags normally come in pairs like <p> and </p> 
 The first tag in a pair is the start tag, the second tag is the end tag 
 The end tag is written like the start tag, but with a forward slash inserted before the tag name 

 Web pages can be created and modified by using professional HTML editors. 
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 However, for learning HTML we recommend a simple text editor like Notepad (PC)  
 Follow the four steps below to create your first web page with Notepad  

 Step 1: Open Notepad (PC) 

 Windows 8 or later: 
 Open the Start Screen (the window symbol at the bottom left on your screen). Type Notepad. 
 Windows 7 or earlier: 
 Open Start > Programs > Accessories > Notepad 
 Then open a new document to place the code. 

 Step 2: Write Some HTML 

 Write or copy some HTML into Notepad. 
 <!DOCTYPE html> 

<html> 

<body> 

 

<h1>My First Heading</h1> 

 

<p>My first paragraph.</p> 

 

</body> 

</html> 

 Step 3: Save the HTML Page 

 Save the file on your computer. Select File > Save as in the Notepad menu. 

 

 

Step 4: View the HTML Page in Your Browser 

Open the saved HTML file in your favorite browser (double clicks on the file, or right-click - and choose 
"Open with"). 

The result will look much like this: 



 

MRCET  Page 66 

 

Department of IT/CSE IT Workshop Lab Manual  

 

HTML Basic Examples 

HTML Documents 

All HTML documents must start with a document type declaration: <!DOCTYPE html>. 

The HTML document itself begins with <html> and ends with </html>. 

The visible part of the HTML document is between <body> and </body>. 

Example 

<!DOCTYPE html> 

<html> 

<body> 

 

<h1>My First Heading</h1> 

<p>My first paragraph.</p> 

 

</body> 

</html> 

HTML Headings 

HTML headings are defined with the <h1> to <h6> tags. 

<h1> defines the most important heading. <h6> defines the least important heading:  

Example 

<h1>This is heading 1</h1> 

<h2>This is heading 2</h2> 

<h3>This is heading 3</h3> 
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HTML Paragraphs 

HTML paragraphs are defined with the <p> tag: 

Example 

<p>This is a paragraph.</p> 

<p>This is another paragraph.</p> 

HTML Links 

HTML links are defined with the <a> tag: 

Example 

<a href="https://www.mrceterp.com">This is a link</a> 

 

 

 

HTML Images 

HTML images are defined with the <img> tag. 

The source file (src), alternative text (alt), width, and height are provided as attributes: 

Example 

<img src=" D:\IT Workshop\mrcetlogo.jpg" alt=" mrceterp.com" width="104"height="142"> 

 

HTML Buttons 

HTML buttons are defined with the <button> tag: 

Example 

<button>Click me</button> 

 

HTML Attributes 

 All HTML elements can have attributes 
 Attributes provide additional information about an element 
 Attributes are always specified in the start tag 
 Attributes usually come in name/value pairs like: name="value" 
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The href Attribute 

HTML links are defined with the <a> tag. The link address is specified in the href attribute: 

Example 

<a href="https://www. mrceterp.com ">This is a link</a> 

The src Attribute 

HTML images are defined with the <img> tag. 

The filename of the image source is specified in the src attribute: 

Example 

<img src="mrcetitlogo.jpg"> 

 

The width and height Attributes 

Images in HTML have a set of size attributes, which specifies the width and height of the image: 

Example 

<img src=" D:\IT Workshop\img_l.jpg" width="500" height="600"> 

 

The alt Attribute 

The alt attribute specifies an alternative text to be used, when an image cannot be displayed. 

The value of the attribute can be read by screen readers. This way, someone "listening" to the webpage, 
e.g. a blind person, can "hear" the element. 

Example 

<img src=" D:\IT Workshop\rose.jpg" alt="Flower with red color "> 

The style Attribute 

The style attribute is used to specify the styling of an element, like color, font, size etc. 

Example 

<p style="color: red">I am a paragraph</p> 

b) Designing a static webpage: Understand how to create a webpage. 
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<!DOCTYPE html> 

<html> 

<head> 

<style> 

body {background-color: powderblue;} 

h1   {color: blue;} 

p    {color: red;} 

</style> 

</head> 

<body> 

 

<h1>This is a heading</h1> 

<p>This is a paragraph.</p> 

 

</body> 

</html> 
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